Contents

1 Introduction .......................................................................................................................... 8
  1.1 About the Guide .............................................................................................................. 8
    1.1.1 Related Documents ................................................................................................. 8
  1.2 Customer Feedback and Suggestions ............................................................................ 8
  1.3 Customer Support Requests ......................................................................................... 9
    1.3.1 Before Submitting a Support Request .................................................................... 9
    1.3.2 Submitting a Support Request ............................................................................... 9

2 Viz Mosart User Interface ................................................................................................. 11
  2.1 Rundown Window ......................................................................................................... 12
    2.1.1 Story Info ................................................................................................................ 12
    2.1.2 Story Elements ....................................................................................................... 13
    2.1.3 Quick Editor ............................................................................................................. 19
  2.2 Program Window .......................................................................................................... 20
    2.2.1 Last Words ............................................................................................................... 20
    2.2.2 On-air Overlay Graphics .......................................................................................... 20
    2.2.3 Template Continue Points ....................................................................................... 21
    2.2.4 Timing Information ................................................................................................... 21
    2.2.5 Auto Take Next ........................................................................................................ 21
    2.2.6 Continue Count ...................................................................................................... 22
  2.3 Preview Window ............................................................................................................ 22
    2.3.1 Lower Thirds ............................................................................................................ 22
    2.3.2 Adjust Video Clip in/out Points ............................................................................... 22
    2.3.3 Timing Information .................................................................................................. 23
    2.3.4 Cued Playout Port/Graphics Engine ........................................................................ 23
    2.3.5 Recue Server ......................................................................................................... 23
  2.4 Video Transition Area .................................................................................................... 23
    2.4.1 Hold Video Transition (H) ....................................................................................... 23
    2.4.2 Next Transition ........................................................................................................ 23
  2.5 Audio Function Area ...................................................................................................... 24
    2.5.1 Hold Audio Transition ............................................................................................ 24
    2.5.2 Keep Sound ............................................................................................................. 25
    2.5.3 Manual Fade Sound ............................................................................................... 25
    2.5.4 Fade Sound ............................................................................................................. 25
    2.5.5 Level 1 and Level 2 .............................................................................................. 25
  2.6 Media Pool ..................................................................................................................... 26
2.15 Wall Manager ........................................................................................................ 83
2.15.1 Creating a Wall Shortcut Item in AV Automation ........................................... 83
2.15.2 Creating a Wall Shortcut .................................................................................. 85
2.15.3 Wall Manager User Interface ........................................................................ 86
2.15.4 Countdown of Video Wall Elements ................................................................. 89
2.15.5 Direct Take Wall Shortcut ............................................................................... 90
2.15.6 Wall Salvo ....................................................................................................... 92
2.15.7 Video Clip Playout Use Cases ......................................................................... 94
2.16 Recording ............................................................................................................ 95

3 Operation ............................................................................................................... 96
3.1 Quick Overview ..................................................................................................... 96
3.2 Select Rundowns from the NCS .......................................................................... 97
   3.2.1 iNews Rundowns ......................................................................................... 97
   3.2.2 MOS Activated Rundowns .......................................................................... 98
3.3 Initialize rundown ................................................................................................. 98
3.4 Running the rundown .......................................................................................... 99
3.5 Skipping a story element ...................................................................................... 99
3.6 Current story ........................................................................................................ 99
3.7 Set as Next Story ................................................................................................. 99
3.8 Running story elements out of story sequence .................................................. 100
3.9 Count down to a selected story ........................................................................... 100
3.10 Using direct take templates ............................................................................... 100
3.11 Pretake next overlay .......................................................................................... 100
3.12 Looping part of the rundown ............................................................................. 101
3.13 Lock rundown or story ....................................................................................... 101
3.14 Rehearsal and on air mode ................................................................................ 102
3.15 Creating sequences ............................................................................................ 103
3.16 Adding stories to the rundown .......................................................................... 103
3.17 Changing template sets ...................................................................................... 104
3.18 Changing graphic profiles .................................................................................. 104
3.19 Standby equipment from the GUI ....................................................................... 104
3.20 Running Viz Mosart in browse mode .................................................................. 105

4 Templates .............................................................................................................. 106
4.1 Template Editor .................................................................................................... 106
4.2 Building Viz Mosart Templates ........................................................................... 106
   4.2.1 Editing Template Sets .................................................................................. 107
4.2.2 Editing Templates ................................................................. 107
4.2.3 Editing Device Functions ................................................... 109
4.3 Template Device Functions .................................................. 110
  4.3.1 Video Switcher Crosspoint ................................................ 111
  4.3.2 Video Switcher Transition ................................................ 112
  4.3.3 Video Switcher Register/Timeline Recall .............................. 113
  4.3.4 Video switcher key bus delegation (Keyfill) ......................... 114
  4.3.5 Video switcher auxiliary bus delegation ............................ 114
  4.3.6 Graphics ........................................................................ 115
  4.3.7 Robotic Camera Control .................................................. 116
  4.3.8 Router control ................................................................. 119
  4.3.9 eLight control ................................................................ 120
  4.3.10 GPI/O .......................................................................... 121
  4.3.11 Video wall register recall ............................................... 122
  4.3.12 Video Server .................................................................. 122
  4.3.13 Audio Player ................................................................... 123
  4.3.14 Virtual Set ...................................................................... 123
  4.3.15 Audio Settings ................................................................. 123
  4.3.16 Testing The Template ...................................................... 124
4.4 Additional Template Functionality ............................................ 125
  4.4.1 State Variance .................................................................. 125
  4.4.2 Dynamic ME Allocation ................................................... 127
  4.4.3 Control Commands in Templates ....................................... 127
  4.4.4 Newsroom Tags Order ...................................................... 135
4.5 Template Examples ............................................................... 137
  4.5.1 Studio ............................................................................. 137
  4.5.2 Video Clip with Full Sound ............................................... 138
  4.5.3 Voiceover ........................................................................ 139
  4.5.4 Live External Source ....................................................... 140
  4.5.5 DVE ................................................................................ 141
  4.5.6 Full Screen Graphics ....................................................... 144
4.6 AutoTake Timing .................................................................. 144
  4.6.1 Autotake Transition with No Effects ................................. 144
  4.6.2 Autotake Transition with Effects and Mix Delay .................... 145
  4.6.3 Autotake Transition with Effects and no Mix Delay ............... 145
5 Audio Panel ............................................................................ 147
  5.1 Audio Panel (Server) .............................................................. 147
<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>5.2</td>
<td>Audio Panel (Client)</td>
<td>147</td>
</tr>
<tr>
<td>5.2.1</td>
<td>Setting up the Connections</td>
<td>148</td>
</tr>
<tr>
<td>5.2.2</td>
<td>Using the Audio Panel</td>
<td>148</td>
</tr>
<tr>
<td>5.2.3</td>
<td>Fader Configuration</td>
<td>149</td>
</tr>
<tr>
<td>6</td>
<td>Audio Player</td>
<td>152</td>
</tr>
<tr>
<td>6.1</td>
<td>How to Set Up Audio Player</td>
<td>152</td>
</tr>
<tr>
<td>6.2</td>
<td>Overview of Audio Player GUI</td>
<td>153</td>
</tr>
<tr>
<td>6.3</td>
<td>Overview of Audio Player Settings</td>
<td>154</td>
</tr>
<tr>
<td>7</td>
<td>Timing Display</td>
<td>156</td>
</tr>
</tbody>
</table>
1 Introduction

This manual explains how to use the Viz Mosart applications, with special focus on the Viz Mosart GUI.

This section contains the following topics:

• About the Guide
• Customer Feedback and Suggestions
• Customer Support Requests

1.1 About The Guide

This guide is a reference guide for use during daily operation of Viz Mosart. The purpose of this document is to help new users become familiar with the system; to illustrate the main workflow, and to show the available options.

1.1.1 Related Documents

1. Viz Mosart Administrator’s Guide
2. Viz Mosart Functional Specification

1.2 Customer Feedback And Suggestions

We encourage suggestions and feedback about our products and documentation.

To give feedback and, or suggestions, please identify your local Vizrt customer support team at www.vizrt.com.
1. Click on **Contact** (top of page).
2. The Vizrt office which is nearest to your location will be shown, or select from the list of Vizrt offices.
3. Click on the Contact button for the office you want.
4. Complete the required details in the window that opens.

**Note:** If this message is for Customer Support, and there is a Support Contract in place, then click on the ‘For support requests, please visit our support portal’ link in the message window.

A Vizrt representative will contact you as soon as possible.

### 1.3 Customer Support Requests

Support Requests are supported by Vizrt if customers have a valid Service Agreement in operation. Customers who do not have a Service Agreement and would like to set up a Service Agreement should contact their regional sales representative (see **Customer Feedback and Suggestions**).

When submitting a Support Request, relevant and correct information should be given to Vizrt Support, to make sure that Vizrt Support can give the quickest and best solution to your Support Request.

#### 1.3.1 Before Submitting a Support Request

Before a Support Request is submitted make sure that you:

**Read:**

- The relevant User Guide or Guides
- The release notes

**and Check:**

- That the system is configured correctly. Always keep track of all changes, and roll back to previous configuration file versions and test this if newly reconfigured.
- That you have the specified hardware, tested and recommended versions

Always refer to your Vizrt Service Level Agreement document.

#### 1.3.2 Submitting a Support Request

When completing a Support Request, add as much information as possible.

**Content of a Support Request**

The report should contain information about these topics:

- **Problem description:** Include a step by step description of what the problem is and how to reproduce it. Specify your workflow. Remember to use simple English.
- **Expected behaviour:** Describe what you expected to happen.
- **Actual behaviour:** Describe what actually happened.
• **Screen shots, illustrations or videos:** Use these to simplify the message. These are extremely useful for Vizrt Support.

• **Software configuration:** Add exact versions of software (-build) used. This is also extremely important information.

• **System locale:** Specify the Region and Language settings of the system. Also the Time Zone setting on the servers and PC’s, as this might be different from local time (some global stations using UTC/GMT setting).

• **System log files:** Send the system log files (see the section on Take Snapshot in the Viz Mosart Administrator’s Guide).

• **Crash log files:** Send the error report and crash log files.

• **Hardware configuration:** Add exact versions of hardware used.

  Optional:

  • **System setup:** Describe differences in the installation, if any, from the recommended setup.
  
  • **Windows event log files** (if deemed necessary or requested by Vizrt)
  
  • **System Network:** Add a description of how the network, bandwidth, routers, and switches are configured.

  Always refer to your Vizrt Service Level Agreement document.

**To submit a Support Request:**

2. Click on **Report a case**.
3. Click on **LOG IN** to login to the Customer and Partner portal.
4. At the top of the Case Management page, click on **Report a Case**.
5. In the online form complete the required minimum information (shown by a red asterisk) and click **SAVE**.
6. In the saved Support Case that opens, complete the various text boxes and upload any required documents, files, etc. (see **Content of a Support Request**).

  To track the status of open support tickets, login to the Customer and Partner portal. Add information or communicate about the cases directly with the support team.
2 Viz Mosart User Interface

The Viz Mosart GUI (Multi GUI) is the main control interface for operators. It’s quite flexible and can be customized to suit your workflow. You can run the GUI on the Mosart server or you can connect one or more GUI’s to the Mosart server over the network.

One quite common customization is to have the shortcuts on a separate touch-enabled screen, for details see Managing your Workspace.

The areas of the Viz Mosart GUI are described in the following sections:

- Program Window
- Preview Window
- Transition Area
  - Video Transition Area
  - Audio Function Area
- Media Pool
- Rundown Window
- Script Window
- Status Bar
- Shortcut Keys (see Keyboard Shortcuts)

In addition, the following editors/panels can also be opened:

- Quick Editor
- Robotic Cameras
- Quick Access Panel
- Wall Manager
2.1 Rundown Window

The rundown window contains the rundown/story list, built from the content received from the NCS.

Each story line consists of a story info area to the left and the Viz Mosart templates and secondary elements extracted from Viz Mosart commands in the NCS, to the right.

2.1.1 Story Info

The left info area of a story normally shows the following information:

1. Estimated on air time in the top left hand corner,
2. The editorial duration of the entire story as entered in the NCS in the top right hand corner,
3. The story title as entered in the NCS on the second line.
4. When the story is on air, another timer appears in the middle of the top line, showing the story run time. The story currently on air is marked as red, and the next story that will be taken to air is marked as yellow.

<table>
<thead>
<tr>
<th>Time</th>
<th>Duration</th>
</tr>
</thead>
<tbody>
<tr>
<td>12:01:06</td>
<td>00:54</td>
</tr>
<tr>
<td>GoogleCHELSEA</td>
<td></td>
</tr>
<tr>
<td>10:52:13</td>
<td>00:04</td>
</tr>
<tr>
<td>Welcome</td>
<td></td>
</tr>
<tr>
<td>10:52:23</td>
<td>01:30</td>
</tr>
<tr>
<td>Syrian conflict</td>
<td></td>
</tr>
</tbody>
</table>

2.1.2 Story Elements

The templates are represented in the right hand area of the rundown window by color coded elements. The length of the element reflects the calculated or exact duration of the template, depending on the template type.

Stories with no recognized Viz Mosart commands are shown as empty lines in the rundown window i.e. without any story elements in the story. Stories with recognized template types but unrecognized variant commands are shown with the variant title in red, as in the illustration below:

The story elements are described in detail in the following sections:

- Primary Story Elements
- Secondary Story Elements
- Further Rundown Features

Primary Story Elements

Camera

The Camera template type is displayed as a green element in the GUI. The variant of the template type (often the camera number) is indicated in the top left hand corner of the colored element. The duration of the template is calculated from the presenter text as entered in the NCS.

Package

The package template type is displayed as a light blue element in the GUI. The variant of the template type is indicated in the top left hand corner of the colored element. The length of the package element is calculated from the actual clip length when available on server.
If the package clip is not available from the video server it has a blue/red checkered pattern, and placeholder clips are displayed with a white/blue-checkered pattern.

**Voiceover**

The voiceover template type is displayed as a light blue and green element in the GUI. The variant of the template type is indicated in the top left hand corner of the colored element. The small notch in the green bar shows the calculated duration of the presenter text. The light blue represents the clip as with the server template type and the green represents presenter text as with the camera template type. If the clip is not available from the server, the clip section of the element has a checkered pattern.

The length of the voiceover element is calculated from the actual clip length when available on server.

**Live/external Source**

The live type is displayed as a red element in the GUI. The variant of the template type is indicated in the top left hand corner of the colored element.

**Graphics**

The fullscreen graphics type is displayed as a yellow element in the GUI. The variant of the template type is indicated in the top left hand corner of the colored element. Duration of the element is timed from the presenter text entered in the NCS. For graphics systems which support this feature, the element has a checkered pattern if the attached graphics content is not available for playout from the graphics system.

⚠️ **Note:** If back-to-back fullscreen graphics are within in the same story (and use the same engine), the scene will not be retaken for each graphic, but just kept playing. When the story is changed, the graphics will be taken again (i.e. the engines are ejected) so that any other graphics that are using the same engine will be taken normally.
Digital Video Effect (DVE)

The DVE type is displayed as a yellow and red element in the GUI. The variant of the DVE template type is indicated in the top left hand corner of the colored element.

Telephone

The telephone interview type is displayed as a yellow and white element in the GUI. The variant of the template type is indicated in the top left hand corner of the colored element.

Ad lib Pictures/Floats

The ad lib pictures template type is represented by a symbol at the right end of the story line in the rundown window. If the associated media object is not on server, the symbol is checkered.

The item will also appear in the Assets window as a colored slug with a green top half and light blue bottom half for clips, and orange bottom half for graphics. They can be taken on air or to preview either by right clicking and using the context menu in the rundown window or the Assets window.

Ad lib picture templates will add the audio faders specified in the template to the current audio fader set. The faders are subtracted when returning from the Ad lib pictures. Ad lib pictures are typically used in live external or studio interviews.
Ad lib pictures pause when it is taken off air. If the Ad lib pictures is inserted again the clip will continue from the paused point.

Break
The break/continuity template is displayed as a white element.

Secondary Story Elements

Overlay Graphics
Overlay graphics are shown as a yellow secondary element. Secondary elements appear on top of primary elements and are executed relative to the primary template. The secondary element is scaled to the duration of the lower third element set in the NCS.

Different types of overlay graphics with separate handlers in the Overlay Graphics application, such as lower thirds, wall items or OSGs, can be displayed in different lowerthird level.

See General Settings for details on setup.

Take In
Take-in of lowerthird items may be performed either manual or automatically from Viz Mosart. If an in-time is set in the NCS for the lowerthird Viz Mosart will automatically take it in. If no time-in is set in the NCS for the lowerthird Viz Mosart will mark it as a manual lowerthird. Manual lowerthird elements are displayed on the right hand side of the GUI window as for adlib pictures. Manual lowerthirds can be executed in the same way as the adlib pictures.

Take Out
Take out of lowerthirds may be performed in four ways. These are displayed differently in the Viz Mosart GUI:

- **AUTOOUT**: Is taken in and taken out automatically from the in-time and duration or out-time set in the NCS
- **BACKGROUNDEND**: Is taken in automatically as defined in the NCS and taken out with the primary element it is attached to.
- **STORYEND**: Is taken in automatically as defined in the NCS and taken out when the story it is attached to is taken off air.
OPENEND: Is taken in automatically as defined in the NCS and is not taken out before the operator takes it out.

Audio Play
Audio Player secondary elements are displayed as a small speaker symbol on top of a primary template. Its position represents the time code given in the NCS. The audio will start to play when the timeline reach the position. If no in-time is defined for the sound it will appear as a manual element in the symbol in the right hand area of the rundown where manual lowerthirds and adlibs are shown.

Accessory Item
Accessory secondary elements are displayed as a small plus (+) symbol on top of a primary template. Its position represents the time code given in the NCS. The Accessory item will be taken when the timeline reach the position. If no in-time is defined for the Accessory item it will appear as a manual element in the symbol in the right hand area of the rundown where manual lowerthirds and adlibs are shown.

If the element has a black background it is normal. If it has a red background the accessory template does not exist. If the background is gray the content is missing.

Further Rundown Features

Story Editorial Time
The story planned duration (editorial time) entered in the NCS is indicated by a grey marker on a story element or after the last story element.

Autotake Items
If a primary story element is programmed with "autotake next" this will be indicated at the end of that element with a black triangular symbol.

Effect Transitions
If an element is set to use an effect transition (from the NCS or the Template Editor), this is indicated with a black and white symbol.
Timing Information
At the top of the rundown window, there are indicators at every 30 second mark. Vertical lines running down the rundown window indicate every second, and broader lines every 10 seconds.

Mouse-over Rundown Info
Hovering the mouse pointer over an element in the rundown displays the script and timed commands connected with that element.

In this example, mousing over the Camera 1 element displays the transition which will be used going into the template - a 4 frame mix - and the template variant “1”. In addition we can see the entire script connected with this template, and the details of a secondary accessory template element.
2.1.3 Quick Editor

To open the Quick Editor, double-click in the info area of a story, on a template or to the right of the last element in a story.

Using this window makes it possible for the user to change the template type and variant of the template clicked. In addition, the template can be removed entirely, or a new one can be inserted after the template clicked.

If you are using a predefined template set from the NCS, this will be shown below the "Remove" button when double clicking a template. Only templates from that set will then be shown in the Quick Editor.

Please note that any stories edited in this way must be locked using the Lock Story from NCS Update command, or they will be deleted on the next reload/resync of the rundown or when the story is changed in the NCS.
2.2 Program Window

The program window is situated in the top right hand corner of the Viz Mosart GUI. It shows information for the currently running story element.

2.2.1 Last Words

Last words will be shown across the bottom of the program window if the last words are available from the newsroom script.

2.2.2 On-air Overlay Graphics

The overlay graphics currently on air are displayed in their corresponding layer. The Viz Mosart GUI has three layers. The lower level is always the lower third level. Level two and three may be configured individually for each graphic type; e.g. OTS (Over The Shoulder) graphics or wall graphics.

If more than 3 overlay graphics are on air at the same time, a small circle appears next to the list, and the operator can scroll up and down the list using the mouse wheel.

Overlays can also be taken off air by right clicking them in the Program window and selecting Take Out.
2.2.3 Template Continue Points

When a Viz Mosart template with built-in continue points goes on air, the descriptive text from template design is displayed. Use the keyboard shortcut for Take Next to take the continue point.

![Hit F12 to Continue DVE.]

2.2.4 Timing Information

The timing information consists of three counters:

1. Counts down time to next break.
2. Counts how much the rundown is over/under.
3. Counts down remaining time for the current on-air template.

- Once it reaches zero, the background color of the counter changes to red and the clock starts counting up.
- Optional: By setting the **Clip visual countdown** (Settings > User Interface - Preview/Program Window) to a value above 0, the countdown of PACKAGE and VOICEOVER will change to pink to alert the user if the countdown reaches this value.

**Example:** If this setting has a value of 10, the counter will change color as follows:

![Example color changes]

2.2.5 Auto Take Next

The auto take next label signals that the Viz Mosart rundown is currently in automatic mode.

![Auto take next label]

Copyright © 2018 Vizrt
2.2.6 Continue Count

The number of remaining continue points in the full screen graphics are displayed in the Program window.

2.3 Preview Window

The preview window is situated at the right hand side of the Viz Mosart GUI. This window displays information for the next story element.

2.3.1 Lower Thirds

The next timed lower third graphic will appear in the preview window until it goes on air.

2.3.2 Adjust Video Clip in/out Points

When the video server driver supports it, the operator can select a new in point and out point for video clips in the preview window. Drag the left and right markers to the desired points. Dragging the in point marker causes corresponding scrubbing to occur on the server, allowing the operator visual preview of the new in point.
2.3.3 Timing Information
The number in the top right hand corner of the preview window indicates the duration of the item currently in preview.

2.3.4 Cued Playout Port/Graphics Engine
The alias of the port which the next clip will be played out from is displayed in the top left hand corner of the preview window. This area is also used to display which fullscreen graphics engine will be used next.

2.3.5 Recue Server
By right clicking inside the preview window, the operator can select to recue a server clip. This is used, for example, to recue and play from the beginning an adlib/float element from its starting point rather than the point it had previously reached.

2.4 Video Transition Area

The transition area is positioned between the preview and program windows.

2.4.1 Hold Video Transition (H)
Pressing **Hold (H)** will hold the video transition when the next template is called. Viz Mosart will wait to do the video mixer crosspoint change until a new Take Next command is issued when the hold video transition is active.

In a situation where you have CAM 1 in a program and a clip (PACKAGE) in preview and use the Take Next with Hold video transition, Viz Mosart will do all of the transitions between the two templates, except the vision mixer crosspoint change. Viz Mosart will fade down the sound from the CAM element and fade up the sound from the clip. It will start to play the video on the assigned video port, and all secondary items with an in-time will use the Take Next as the relative starting point.

The Viz Mosart GUI Program window will notify the user that the video transition is on hold and that the user needs to send a new Take Next to do the vision mixer crosspoint change. This functionality can also be toggled to be auto-taken in a template or by a keyboard shortcut key.

2.4.2 Next Transition
The type of the next vision mixer transition is shown in the transition area by highlighting the corresponding transition icon. Available transition types are **Mix (M)**, **Wipe (W)** and **Effect (E)**. In the value field to the right of the transition type boxes, the duration of **Mix (M)** or **Wipe (W)** is shown, or, for **Effect (E)**, the name of the effect is shown.
The next vision mixer transition can be overridden by clicking on the corresponding transition icon in the transition area. For Mix (M) and Wipe (W) transitions, the duration of the transition (in frames) can be changed by clicking M or W, and then use the scroll-wheel, or right-click and drag up or down in the duration field.

Selecting Effect (E) and then clicking the empty square will cause a dropdown menu to appear, containing the transition effects stored in AV Automation’s A/V Setup.

When Studio Setup is changed, the items in the dropdown are updated accordingly. For more information on configuring Studio Setup, see the Viz Mosart Administrator’s Guide > Audio and Vision Mixer Effect Setups.

The next transition type can also be selected by a TRANSITION TYPE control command. By default, this control command is assigned to the Tabulator key, which can then be used to cycle through the three transition types.

2.5 Audio Function Area

This area indicates the special audio functions. When a function is active the button is colored in blue. The functions can be activated either through keyboard shortcuts or by clicking on the buttons.

2.5.1 Hold Audio Transition

Pressing Hold (H) will hold the audio transition when the next template is called. Viz Mosart will wait to do the audio mixer fader change until a new Take Next command is issued when the hold audio transition is active.

In a situation where you have CAM 1 in program and a clip (PACKAGE) in preview and use the Take Next with Hold audio transition active Viz Mosart will do all transitions one would expect between the two templates except the audio mixer fader change. Viz Mosart will change the cross point on the vision mixer to the PACKAGE element. It will start to play the video on the assigned video port, and all secondary items with an in-time will use the Take Next as the relative starting point.

The Viz Mosart GUI Program window will notify the user that the audio transition is on hold and that the user need to send a new Take Next to do the audio mixer fader change. This functionality can also be toggled to be auto-taken in a template or by a keyboard shortcut key.
2.5.2 Keep Sound

CTRL+K (default) or clicking the button in the GUI will activate Keep sound levels. This will keep the currently active audio faders and their levels until deactivated with another CTRL+K (default) press. All audio fader configurations in story commands will be ignored as long as the keep sound mode is active.

2.5.3 Manual Fade Sound

The Manual fade sound mode will allow the operator to start an audio fade prior to the F12 to next element or after the F12 to the next element.

To enable manual fading for the sound of the current story element, activate the Manual fade sound mode by using CTRL+M (default) or clicking the relevant indicator button.

The current on air set of audio faders will be kept open through the next story until they are faded using CTRL+F (default), while the faders connected with templates in the next story are added to and subtracted from them. To disable the Manual fade sound without fading, press CTRL+M (default) again. The duration of the fade is set as a global value in the AV Automation settings.

2.5.4 Fade Sound

CTRL+F (default) will fade all open faders set to keep in the Template Editor.

2.5.5 Level 1 and Level 2

Each Viz Mosart template can be configured with three audio level setups for the complete set of audio faders defined in the template, two of which can be accessed from the GUI. Level 1 is set as default in a template, while level 3 is the fader’s base On level (normally Out equals In). It can be modified from the AV Automation application.

CTRL+L (default) will toggle level 2 for all faders in the template cued in preview. Level 2 will be used when the previewed element is taken on air with F12.

SHIFT+CTRL+L (default) will immediately use level 2 for all faders in the template currently on air.
2.6 Media Pool

This panel has four tabs:

- Assets Tab
- Search Tab
- Favorites Tab
- Quick Access Tab

2.6.1 Assets Tab

The Assets Tab shows the various assets for a story as received from the NCS. Note that any content added to the story from the Viz Mosart GUI will not be part of the assets. This tab lists the story elements available in the selected story or group. From the Asset window, these elements can be used in several ways.

Elements can be dragged directly from the asset window and into the rundown window to add and edit the currently loaded rundown. All elements are added at the point at which they are released - primary elements like lives or packages are inserted before or after another primary element, and secondary elements like lower thirds are added to the primary element they are dropped onto. The elements will be added to the rundown with the template type that it is entered in the NCS. Any modification to the rundown will disappear on the next Reload or when the story is changed in the NCS, unless the story is locked.
Elements can be dragged to a shortcut button in the shortcut keys window, to be recalled later with a single keystroke. See Keyboard Shortcuts.

Elements can be dragged to the Favorites Tab to be stored for easy access.

The legends corresponding to the various template types and are customizable, see User Interface - Assets.

Context Menu

Right-clicking an element in the assets window will display, a context menu as in the illustration below.

- Clicking Directtake takes the element to air immediately.
- For secondary elements with a duration Directtake OUT takes them off air again.
- Clicking Preview adds the clicked primary element as the next story element in the rundown.
- Recue > Recue will recue the video content of a template with video content that has been previously played. Recue > Recue and Preview will also add the template to the timeline in the next position.

- In the Show Template types context menu the operator can choose which Viz Mosart types will be visible in the Assets window. i.e CAM, PACKAGE, VO, LIVE, GRAPHICS, DVE, TELEPHONE, FLOAT, LOWERTHIRD, SOUND, ACCESSORY.

Other actions:

- The Assets can be sorted by selecting the Sort option in the menu. Sorting by Template will display the assets in order by Template. The None option will show the assets in the same order as in the story.
- Hovering the cursor over an item in the Assets window will display more information about the item, including any secondary elements attached to it.
2.6.2 Search Tab

The Search (ClipSearch) tab will search for clips on connected video servers. These can then be dragged onto shortcut buttons which have been predefined with a template designed to contain a video file. The search field is case sensitive.

**Example:**

Create a shortcut key for a Package type template which allows drop of content (for details see Keyboard Shortcuts). Then use the Search window to find another video file, and drag it onto the same button. The video file will now be executed within the template assigned to the button.

Additionally, elements can be dragged directly from the search window to shortcut keys and to the Media Pool and Rundown windows.

**By default:**

- Dragging will drop the file as an Adlibpix type with variant default
- `SHIFT+drag` will drop it as a Package type with variant default
- `CTRL+drag` will drop it as a Voiceover type with variant default.
  
  See General Settings for more information on setting up this feature.

2.6.3 Favorites Tab

The Favorites Tab can be used to gather primary and secondary elements from several stories in the rundown, creating a temporary toolbox for the operator. The Favorites Tab has similar functionality to the Assets window. To add elements to the Favorites Tab, select the story
containing them in the rundown window, then drag the desired elements into the Favorites Tab. From here, they can be dragged to the rundown, to shortcut keys, *Direct Take to air or to Preview, or Removed through a right click context menu.

To remove all collected elements from the Favorites Tab, right click on the tab and select Clear Pool.

By right-clicking an element in the Favorites window, a context menu appears. Clicking Directtake takes the element straight to air immediately. Clicking Preview adds the clicked primary element as the next story element in the rundown. Clicking Remove removes the item from the Favorites Tab.

Hovering the cursor over an item in the Favorites Tab will display more information about the item, including secondary elements attached to it.

Right clicking the Favorites Tab brings up a context menu which allows the user to clear the pool of all content.

2.6.4 Quick Access Tab

The Quick Access Tab (QAT) gives the user yet another way to interact with the rundown, it displays all the elements in the entire rundown.

The QAT is an enhancement of the Quick Access Panel and shares the filter functionality. Any filters applied to one of them will immediately be applied to the other. It is possible to filter by type, status (on air, preview, aired etc.), slug, story title, available, unavailable.
Elements can be dragged anywhere in the rundown, and they will then be attached to that story or item. It is also possible to drag secondary elements directly into any primary element.

Elements can be dragged to the Favorites Tab to be stored for easy access. They can also be dragged onto a Keyboard Shortcuts button in the shortcut keys window.

The context menu that appears when right-clicking on an element provides the same functionalities as in the Assets Tab tab.

**Operation**

The QAT can be operated with keyboard and mouse. The configurable keyboard shortcuts mentioned above should be used. The mouse or keyboard can be used to select multiple items. By holding **CTRL** while using the mouse the item can be set as group-selected/unselected. By using the NEXT_GROUP_ITEM keyboard command Viz Mosart will step through the selected items.
The items can be grouped by story, or listed without showing the stories. In this example only the lower thirds are visible.

Story, item and sub-item on-air indication:

Lower thirds can be taken both to air and off air. While they are on air the on air indication will be visible. All items in the list can be drag-and-dropped directly to the favorites tab, wall items, timeline or keyboard shortcuts. It is possible to show and control all kinds of VizViz Mosart elements in this view.
2.7 Script Window

The Script window can be used to edit elements already in the rundown.
This section contains more information on the following topics:

- Script Window Display
- Timing Information
- Editing Primary Elements
- Editing the Script Displayed in Viz Mosart
2.7.1 Script Window Display

The Script window shows all the content in two stories: the top half shows the on-air story, or the first story that will go on air. By default, the bottom half shows the next story to go on air. Clicking another story in the rundown will display it instead of the next on-air story. On the next F12 which changes the on-air story, the view will revert to default.

The top line of each story in the script window shows the estimated on air time of the story, and the story name and editorial duration of the story as given in the NCS.

Below this, each template and secondary element is displayed chronologically, using the same color coding as in the rundown window. The complete contents of the script are also displayed, along with any written Viz Mosart commands in the script window.

Primary story templates are displayed with their in time only, while secondary elements show durations as well.

2.7.2 Timing Information

At the top of the script windows are two timing indicators. To the left is the total planned time for the story currently on air. To the right this time is counted down from the start of the story.

As soon as this timer reaches zero, the story timing information area turns red and the clock starts counting upwards, to indicate planned duration overrun.

2.7.3 Editing Primary Elements

The variant of any template type can be changed by clicking it in the script window and selecting a new variant from the pull down menu.
In the same manner, the transition for that template can be changed by clicking the current transition type and selecting the desired transition type from the pull down menu.

The transition duration or effect number can be typed into the field between the two menus.

Please note that any stories edited in this way must be locked using the Lock Story from NCS Update command, or they will be deleted on the next reload/resync of the rundown or when the story is changed in the NCS.

2.7.4 Editing the Script Displayed in Viz Mosart

Please note that any stories edited in this way must be locked using the Lock Story from NCS Update command, or they will be deleted on the next reload/resync of the rundown or when the story is changed in the NCS.

2.8 Keyboard Shortcuts

The Shortcut Keys area is situated across the bottom of the Viz Mosart GUI and displays the shortcut keys that have been configured.

This section contains:
2.8.1 Keyboard Shortcuts Editor

All keyboard shortcuts for the Viz Mosart GUI are fully customizable. To create or edit a keyboard setup, go to **Tools > Keyboard Shortcuts > Keyboard shortcuts editor**.

Several sets of keyboard shortcuts (referred to as Keyboard Layouts) can be stored and recalled through the Layout menu or a designated shortcut. However, to facilitate training and technical support, a default setup similar to the basic setup described in this manual is recommended.

The Keyboard Shortcut Editor is divided into four areas:

- **Shortcut List**
- **Editor Window**
- **Menu Bar**
• Keyboard Layout Preview

Shortcut List

This window lists all the shortcut keys in the currently loaded keyboard layout, grouped by their functionality.

From the context menu, you can **Move**, **Remove** or **Copy** items. To **edit** an existing shortcut, select it in the shortcut list.
Editor Window

The options available for each shortcut in the editor window are mainly dependent upon the type of shortcut being created or edited. The four main types of shortcuts are Template keys, Control Command keys, Timeline keys and Layout keys.

Menu Bar

To create a new keyboard shortcut, select Add new shortcut from the menu bar and choose a type of shortcut from the list in the Editor Window. To remove a shortcut, select it in the Shortcut List and click Remove. Whenever changes have been made to a keyboard layout, Save must be used to apply them.
2.8.2 Creating Keyboard Shortcuts

For all types of keyboard shortcuts, the top line of the Keyboard editor is identical. To associate a shortcut with specific keys, click the center square (F12).

A red, pulsating circle appears. Press the desired keys. The main key will be entered into the square, while any modifier keys will be highlighted to the left. The name to appear on the shortcut button itself can be entered in the rectangle to the right.

2.8.3 Template Keys

Template keys are shortcuts connected to the various templates created in the Template Editor. Because of this, some options may be unavailable depending on the templates created in an individual system.

**VARIANT SELECTOR**: The down arrow next to the template type allows the user to select from the list of available variants (templates previously created). Note that only the templates from the active template set will be available here. To select a variant that is only available in a different set it must be selected prior to assigning the key.

The parameters available for the Viz Mosart Types are:

**Touchmode**: This parameter defines what pressing the key on the keyboard shortcuts window panel using a touch screen or clicking on it with the mouse cursor does.

**Select** highlights the key, and the operator can then press either the Program or Preview window to take the template to air or to preview. When a shortcut is clicked on the panel by the user it will be highlighted and a **Set as Selected** button will appear in the Program and Preview window. By pressing one of these buttons the user can set the selected template to either program or preview.
**Preview** takes a touched template to preview.

**OnAir** takes a touched template straight to air.

**None** disables touch control for the key. It may still be fired by pressing the assigned key on the keyboard.

**Key press option checkboxes:**

**Preview**: When the key is pressed, the template is taken to preview instead of to air. Do not confuse this with Preview from touch mode.

**Insert**: Inserts the template as the next element without replacing the existing next primary element (if the next primary element was added via a shortcut earlier).

**Neither selected**: The template is taken to PRG

**Template binding option checkboxes:**

**BIND TO NCS CONTENT**: The key will take its content, such as associated video clips, from that defined in the NCS for the last played or selected story.

**BIND TO NCS TEMPLATE**: The key will take its template variant, such as camera number or external source, from that defined in the NCS for the last played or selected story.

**BIND TO NCS SLUG**: The key will take its slug from that defined in the NCS for the last played or selected story.

**ALLOW DROP**: Checking this box makes it possible to drop other templates onto this key in the shortcut window, effectively overwriting the key until the keyboard layout is reloaded.

**DROP CONTENT ONLY**: This parameter is only available when the Allow Drop parameter is already checked. Checking Drop Content Only ensures that only content, like video files, can be dropped onto the key without replacing its associated template.

**Lowerthirds (special case):**

If a template key is specified as a lowerthird some additional options appear.

**DEFAULT**: Takes the template to air if not already taken. If then it takes it off air.

**AUTO**: Will take the lowerthird to air. If already on air it will take any continue point or take it off air.

**CONTINUE**: Will take the next continue point.

**TAKEIN**: Will take it to air.

**TAKEOUT**: Will take it off air.

**Bind to NCS exclusive**: If unchecked the next lowerthird template (in the list) will bind to the same ncs content again. Convenient if the operator want e.g. a take in, continue and takeout shortcut of the same lowerthird from the NCS and can have multiple lowerthirds in an story.
Default Setup

A default setup is suggested (and can be provided on request) containing the following Template keys. Because the use of Touch Mode is highly individual, this is left to its default, Select:

F1 - Camera 1 (Set with no parameters, so it is taken straight to air)
F2 - Camera 2 (Set with no parameters, so it is taken straight to air)
F3 - Camera 3 (Set with no parameters, so it is taken straight to air)
F4 - Camera 4 (Set with no parameters, so it is taken straight to air)
SHIFT+F1 - Set Cam 1 in ME1 Key 1
SHIFT+F2 - Set Cam 2 in ME1 Key 1
SHIFT+F3 - Set Cam 3 in ME1 Key 1
SHIFT+F4 - Set Cam 4 in ME1 Key 1

F5 - Live Drop Key: (Set up to go to Preview, and with all Bind... parameters selected. This causes the shortcut to get all the properties of the last run or selected Live template. To select a template in this way, click its story in the rundown.)

F6 - DVE Drop Key: (Set up to go to Preview, and with all Bind... parameters selected. This causes the shortcut to get all the properties of the last run or selected DVE template. To select a template in this way, click its story in the rundown.)

F7 - Telephone Drop Key: (Set up to go to Preview, and with all Bind... parameters selected. This causes the shortcut to get all the properties of the last run or selected Telephone Interview template. To select a template in this way, click its story in the rundown.)

F8 - Ad Lib Drop Key: (Set up to go to Preview, and with all Bind... parameters selected. This causes the shortcut to get all the properties of the last run or selected Ad Lib template. To select a template in this way, click its story in the rundown.)

1 - Live source 1 (Set with Preview parameter)
2 - Live source 2 (Set with Preview parameter)
3 - Live source 3 (Set with Preview parameter)
4 - Live source 4 (Set with Preview parameter)
SHIFT+1 - Set Live 1 in ME1 Key 2
SHIFT+2 - Set Live 2 in ME1 Key 2
SHIFT+3 - Set Live 3 in ME1 Key 2
SHIFT+4 - Set Live 4 in ME1 Key 2
2.8.4 Control Command Keys

Control Commands are commands the operator can send directly to one of the connected devices independent of templates currently in use. A DVE FORWARD command can be sent to the vision mixer or a Continue graphics command can be sent to the connected graphics system. They can also be used to change template set, graphics profile, or to set the system in AUTOTAKE mode.

In addition to being assigned to shortcuts, control commands can be set into the timeline from the NCS using written commands, or they can be attached to templates either as continue points or to be automatically performed when a template goes on or off air.

Most of the Control Commands have parameters attached to them, and are described below:

- AUDIO
- AUTOTAKE
- AUTOTRANS
- DIRECCTAKE
- DVE
- ENABLEGRAPHICS_MIRRORING
- FULLSCREENGRAPHICS
- GRAPHICSPROFILE
- LIGHT
- MARKER
- OVERLAYGRAPHICS
- SETAUX_CROSSPOINT
- SETCROSSPOINT
- SETCURRENT_ME
- RUNDOWNNCS_RESYNC
- SEQUENCE
- STUDIOSETUP
Using the Control Commands

Control commands can be used in two ways beyond as keyboard shortcuts:

1. Inserting a Control Command in the Viz Mosart Timeline from the NCS
2. Use a textual command, either as a machine command in iNews or such as this in ENPS:

   (**COMMAND=DVE FORWARD <00:04**)

   This command will perform a DVE FORWARD four seconds into the main item.

Attaching Control Commands to a template

Some control commands can also be attached to a template. Please refer to the *Viz Mosart Administrator’s Guide* for detailed instructions.

Parameters with Placeholders

Control commands parameters may contain placeholders which can be replaced with values found in the fields of the Viz Mosart item which is currently on-air. See the Parameters with placeholders section in Additional Template Functionality.
Add New Command

The Add new command button allows users to add multiple commands to a shortcut. These commands will be executed sequentially from left to right.

Common Parameters

Touch Mode

All control command keys share the "TouchMode" parameter. "OnAir" indicates that clicking or pressing the keyboard shortcut in the shortcut window will immediately execute the relevant control command. "None" disables touch/click functionality for the button.

AUDIO

Audio Control Commands have an associated fade rate parameter, which allows the operator to set a fade rate in frames where relevant.

Audio Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FADE OUT KEEPS</td>
<td>Faders that are set as &quot;keep level&quot; in the template on air will be faded out.Default: CTRL+F</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>FADE MANUAL</td>
<td>The audio faders for the On-Air server channel are set to Manual control, and will not be changed by Viz Mosart until taken out of manual control again. Default: <strong>CTRL+M</strong></td>
</tr>
<tr>
<td>FADE UP SECONDARY AUDIO</td>
<td>Viz Mosart will fade up relevant audio sources not connected to the video currently on air, when cutting between sources. For example, when cutting from a camera to a live source, internal Viz Mosart logic dictates that all the microphones in the camera template are left up. Pressing <strong>SHIFT+F10</strong> will fade the camera template microphones down. <strong>F10</strong> will bring them back up again, for example to allow the presenter to talk to a reporter at the end of a live segment. Default: <strong>F10</strong></td>
</tr>
<tr>
<td>FADE DOWN SECONDARY AUDIO</td>
<td>Viz Mosart will fade down relevant audio sources not connected to the video currently on air. Default: <strong>SHIFT+F10</strong></td>
</tr>
<tr>
<td>FREEZE AUDIO</td>
<td>With the Control Command Freeze Audio all sound faders are frozen, and do not respond to commands from templates. This command is a toggle function. Default: <strong>CTRL+K</strong></td>
</tr>
<tr>
<td>SET LEVEL 2 PREVIEW</td>
<td>The second level for faders in the template will be set on the template which is in preview, and be performed on next transition. Default: <strong>CTRL+L</strong></td>
</tr>
<tr>
<td>SET LEVEL 2 ONAIR</td>
<td>The second level for faders in the template which are on-air will be set. Default: <strong>SHIFT+CTRL+L</strong></td>
</tr>
</tbody>
</table>

**AUTOTAKE**

Set the Viz Mosart system to auto take mode.

**PARAMETERS:** The key can be defined as a toggle key, or two separate keys can be used to activate or deactivate autotake mode.

Default: Toggle with **CTRL+SHIFT+A**

**AUTOTRANS**

This will tell the switcher to perform a transition on a given ME between the currently cued and on-air source.

**PARAMETERS:** ME and transition rate
DIRECTTAKE
This key will execute a directtake template.
PARAMETERS: Number of the directtake template

DVE
Send a forward or reverse command to the DVE in the vision mixer.
PARAMETERS: Set to forward or backward.
Default: Forward with PageUp
Default: Backward with PageDown

ENABLEGRAPHICS_MIRRORING
Target: FULLSCREEN, OVERLAY, ALL - Where to enable/disable graphics mirroring
Action: ENABLE, DISABLE - What to do

FULLSCREENGRAPHICS
CONTINUE: Send a continue command for a fullscreen graphic on a graphics engine.
PARAMETERS: Choose a specific engine, or use current to send the command to the engine currently on air.
Default: Send a continue to the current engine with F11
MACRO: For graphics systems that support this function, this sends a macro command to the defined engine. The Parameter field is in the form <engine>:<Macro>. The macro is a public macro on Viz Trio.

GRAPHICSPROFILE
Change the current graphics profile loaded.
PARAMETERS: Enter the name of the desired graphics profile

LIGHT
Activate a specific light setup.
PARAMETERS: Enter the number of the desired scene

MARKER
Inserts a metadata marker into the timeline.
PARAMETERS: Description to be entered for the marker.
OVERLAYGRAPHICS

All Overlay Graphics commands share the Render parameter. This parameter can be set to send
the given command to a specific engine, or to engines which currently have active graphics on air.
In addition, the Parameter value has varying functionality depending on the chosen command.

- **CONTINUE**: If the current overlay graphic contains stop points/triggers, this command will
  continue the timeline. Parameter has no effect. Default: Send a continue with \textit{SHIFT+F11}
- **MACRO**: For graphics systems that support this function, this sends a macro command to
  the defined engine. The Parameter field is in the form \textit{<engine>:<Macro>}. The macro is a
  public macro on Viz Trio.
- **TAKE MANUAL OUT**: This command takes out overlay graphics which have been set to wait
  for a manual take out. Parameter has no effect. Default: \textit{SHIFT+Home}
- **TAKE LAST OUT**: This command takes out the last overlay graphics which have been taken
  in. Render value has no effect. In the Parameter field, it is possible to enter a graphics
  Handler name (i.e. WALL or DSK etc). Default: Home
- **PRETAKE NEXT**: With this command, the next overlay graphics in the timeline will be taken
  in. In the Parameter field, it is possible to enter a graphics Handler name (i.e. WALL or DSK
  etc). This value will override the Render value. Default: \textit{CTRL+O}
- **CLEAR**: This command takes out all on-air overlay graphics. Parameter has no effect. Default:
  \textit{CTRL+X}

SETAUX_CROSSPOINT

Sets a crosspoint on one of the AUX buses on the mixer.

PARAMETERS: Select bus and specify crosspoint.

SETCROSSPOINT

Sets a crosspoint on the vision mixer.

PARAMETERS: The operator can choose the ME, bus (A, B or keyers) and crosspoint for the
command.

SETCURRENT_ME

This command sets a given ME on air.

PARAMETERS: Choose an ME.

RUNDOWNNCS_RESYNC

Initializes a reconnect to the NCS.

SEQUENCE

This command contains controls for a sequence as defined in a template.
START: Restarts a previously stopped sequence.
STOP: Stops a running sequence.
STARTLOOP: Sets a running sequence to start looping.
STOPLOOP: Stops running a looped sequence in loop

STUDIOSETUP
Change the current studio setup (template set) loaded.
PARAMETERS: Enter the name of the desired studio setup.

VIDEOWALLMODE
This toggles a mode where key parts of production are shifted via an ME to a connected video wall (e.g. video server ripple, but not camera switching). It is not recommended to use this feature without consulting Viz Mosart support.
PARAMETERS: The ME to be used.

TAKE_SERVER_TO_PROGRAM
Takes a video server port to program on a selected ME. For example: a video clip is running on a video wall. The shortcut can then be used to
PARAMETERS: Select on which ME the video server should be taken to program, and the transition rate to use.

TRANSITIONTYPE
This command sets the transition type to use on the next transition.
PARAMETERS: The type can be set including Toggle, which cycles through the various transition types. In the Value field, the transition rate in frames can be set, or the effect number for the mixer effect transition type.
DEFAULT: Tab is set to Toggle.

WEATHER
This command controls the timeline of a connected Viz weather system.
- PLAY: This command starts the timeline of the weather system.
- CONTINUE: When a weather timeline has stop points, this command sends continue commands to the timeline.
- GO TO FIRST: This command cues the weather scene to its first page/frame.

ACCESSORIES
Pretake of accessory. Pretake requires accessory template to have preload enabled and also a primary type to trigger the pretake defined. Only use accessories with in-time=0
SETVIDEOSERVER_SALVO
Switch to the videoserver salvo specified in the combobox parameter.

NCS
NCS [OpenMedia]
Start\Stop rundown/story/item status.

SWITCHVIDEOSERVER_MIRRORING
Toggles a switch of any mirrored video ports

SWITCHGRAPHICS_MIRRORING
TOGGLE - Toggles mirroring mode for graphics for fullscreen graphics
ACTIVATE - Activates mirroring mode
DEACTIVATE - Deactivates mirroring

RECORD
Parameters:
- Command (PREPARE, START, STOP)
- PREPARE - cue record for the specified Recorder on PortName for recording to the specified file with the clip name.
- START (only supports the Recorder parameter)
- STOP (only supports the Recorder parameter)
- ClipName - the name of the recorded clip
- Recorder - the name of the recorder. A value of Default will select the default recorder.
- PortName - the name of the recorder port. Default value is “Rec”. It is always in the “Rec” group.

QUICKEVENT
Quickevent control command has the following commands:

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>NEXT_ITEM</td>
<td>Viz Mosart will select the next group-selected item (down).</td>
</tr>
<tr>
<td>NEXT_GROUP_ITEM</td>
<td>Viz Mosart will select the next item (down).</td>
</tr>
<tr>
<td>PREVIOUS_ITEM</td>
<td>Viz Mosart will select the previous pre-selected item (up).</td>
</tr>
</tbody>
</table>
**Name** | **Description**
--- | ---
PREVIOUS_GROUP_ITEM | Viz Mosart will select the previous item (up).
TAKE_SELECTED | Viz Mosart will attempt to put any selected item to air.
TAKE_SELECTED_TO_WALL | Viz Mosart will take the selected item to the wall item specified in the parameter.
PREVIEW_SELECTED | Viz Mosart will attempt to put the current selected item to preview.
PREVIEW_SELECTED_TO_WALL | Viz Mosart will put the selected item to the selected wall salvo preview wall item specified in the parameter. See Wall Manager.
PRELOAD_SELECTED | Viz Mosart will try to preload the current selected item to any preload port/engine.
FILTER_LEFT | Viz Mosart will switch the selected filter to the filter displayed to the left of the currently selected filter (this will also work with QAP).
FILTER_RIGHT | Viz Mosart will switch the selected filter to the filter displayed to the right of the currently selected filter (this will also work with QAP).
CLEAR_SELECTION | All selected or group-selected marks will be removed.
TOGGLE_SELECT | Viz Mosart will mark the current item in the list as group-selected.
LOWERTHIRD_ACTION_SELECTED | Viz Mosart will mark the current item in the list as group-selected.

**VIDEOPORT**
Command for sending a specific command directly to a specific video port. Not applicable for all video servers. Behavior varies depending on video server type.

This is will not be visible in the rundown! (only visible in Wall Manager)

**Action**: What action to perform on clip assigned to port
- **PLAY_PAUSE**: Play or Pause assigned clip
- **STOP**: Stop assigned clip
- **CUE**: Cue assigned clip
- **RECUE**: ReCue assigned clip
- **SET_LOOP**: Tells the video player to loop the current clip
- **PLAY_TAIL**: Skip to end of clip and start playing. Use parameter e.g. -10 to skip to 10 seconds before end of clip. Used for rehearsal.
- **CUE_TAIL**: Same as PLAY_TAIL but does not start to play.
**VideoPort:** Name of VideoPort to send command to.

**Parameter:** Used for PLAY_TAIL and CUE_TAIL commands. Specified length from end or start of clip to skip to. Use negative number to count from end.

**DEVICEPROPERTY**

n/a

**USERMESSAGE**

Writes a simple message to the log

**OVERLAYTO_MANUAL**

Converts all lowerthirds (overlays) to manual for the current, preview or selected story.

The control command OVERLAY_TO_MANUAL has three optional parameters:

- Parameter 1: The type of story to be converted, either:
  - SELECTED (default): The selected story. Used for GUI.
  - PREVIEW: The story in preview
  - ONAIR: The on air story
- Parameter 2: Comma-separated list of handler names, e.g. WALL, DSK. Empty list means all handlers.
- Parameter 3: Method for the converted overlays to be taken out, either:
  - AUTOMATIC (default)
  - MANUAL

When activated, OVERLAY_TO_MANUAL will convert all lowerthirds in the specified story (Parameter 1) with the specified handler name (Parameter 2) to MANUAL. If no handler name is specified it will convert all lowerthirds in that story to MANUAL. If Parameter 3 is set to MANUAL, the converted overlays also have to be taken out manually, otherwise they are taken out (automatically) after the specified duration.
2.8.5 Timeline Keys

The timeline keys are the four basic commands that directly affect the running of a rundown in Viz Mosart:

- **Reload**
- **Start Continue**
- **Skip Next**
- **Un-Skip Next**
- **Skip Next sub item**
- **Un-Skip Next sub item**
- **Set As Next Story**
- **Set As Next Story And Skip**
- **Hold Video Transition**
- **Hold Audio Transition**

Reload

Default **SHIFT+F12**

This command will stop playout and reload the current rundown, cuing the first story in the rundown in preview.

Start Continue

Default **F12**

This command will do one of four things:

1. Start a rundown which is currently not running, either at the top or at a point selected by the operator using the Set as Next Story command in the Rundown Window.
2. Take the next template within a story to air.
3. Take the first template in the story set as next if there are no more templates left in the current story.
4. The Take Next command is also used to take continue points that have been set in a template, such as a DVE forward on the mixer. A warning appears in the bottom of the Program window to alert the operator that the next F12 will activate the continue point rather than take the next primary event.

PARAMETERS: A default transition type for F12 can be set.

**Skip Next**

Default **F9**

This command will skip the next item in the rundown. Repeatedly giving this command will skip several items.

**Un–Skip Next**

Default **SHIFT+F9**

This command will undo skipping performed with the SKIP NEXT command, in reverse order.

**Skip Next sub item**

No default button

This command skips the next sub item i.e. lowerthird

**Un–Skip Next sub item**

No default button

This command undoes the latest skip next sub item command

**Set As Next Story**

No default button

Sets the selected story as next

**Set As Next Story And Skip**

No default button

Sets the selected story as next and removes (skips) any remaining items in the current story.
Hold Video Transition
No default button
Hold the video transition. Same as pressing the top H-button on the program\preview panel

Hold Audio Transition
No default button
Hold the audio transition. Same as pressing the bottom H-button on the program\preview panel

2.8.6 Layout Keys

![Keyboard Layout](image)

**Keyboard Layout**
Adds a shortcut to change the current keyboard shortcut setup to a user-defined Keyboard Layout.
PARAMETERS: The desired layout can be selected from a pulldown menu.

**Workspace**
Adds a shortcut to change the GUI layout to a user-defined Workspace.
PARAMETERS: The desired workspace can be selected from a pulldown menu.

2.8.7 Creating Wall Buttons
To create a wall button, select the option **Wall buttons > Wall1** in the menu.
Then an accessory template needs to be selected. (more about the wall accessory template in the Wall Manager section).
The wall button placement inside the wall canvas can be modified in the Wall Manager (reference to the new Wall Manager section).

2.8.8 Exporting/Importing Shortcuts From Server
Select EXPORT in the menu to export a shortcut set to the server. The server command prompt should display something like this:
To import the server set you simply select the IMPORT menu item in the keyboard shortcuts.

It is also possible to Import the keyboard shortcut set from the server from the MainGui.

Tools > Keyboard shortcuts > Import shortcuts from server

The server shortcuts will overwrite the local shortcuts. It is possible to enable a setting to always import the server shortcuts when starting the MainGui.

Tools > General Settings
User interface > Keyboard > Import keyboard shortcuts on startup

2.8.9 On Air Shortcut Operations

It is possible to drag and drop template elements directly onto buttons in the main Viz Mosart window. To do this, simply drag an element from the Asset or Favorites Tabs and onto a button. Using the specially defined drag and drop functionality is described in Media Pool and General Settings.

Note that on the fly buttons are saved to the keyboard setup.

Shortcut context menu

To remove a button, right click it and select Clear.

Templates are saved to buttons with all their secondary items, including lower thirds and audio files. To clear these, right click the button and select Clear sub items.

Any NCS bound keys can be reset to its original state by selecting the reset option.

2.8.10 Video Port Control Commands

The video port control commands can be used for manual override control of specific video ports from the Viz Mosart GUI. This section will explain how to set up the shortcuts.

⚠ Note: Not all of video server drivers supports all the command variants described here.

This section includes the following topics:

- Video Port Keyboard Shortcuts
- Video Port Groups
- Control On Air or Preview Video Port
Video Port Keyboard Shortcuts

To be able to use the video port control commands you need to add a set of shortcuts for each video port. You have to create a new set for each video port A, B, C etc. Here port A will be used as an example.

For all examples VideoPort = A

- **PLAY_PAUSE**: Viz Mosart will begin to play the cued content. If the content is already playing, it will pause the content
  - Empty Parameter: PAUSE if playing and PLAY if paused
  - Parameter: PLAY. Always try to PLAY channel
  - Parameter: PAUSE. Always try to PAUSE channel

- **STOP**: Viz Mosart will stop the cued content.
  - Parameter: CUE. Cue the channel after the stop

- **RECUE**: Viz Mosart will RECUE the port
  - Parameter: PLAY. Viz Mosart will play the clip after the recue

- **SET_LOOP**: Viz Mosart will set the already cued clip to looping
  - Parameter: OFF, RESET. Viz Mosart will turn the looping off
  - Parameter: 12-444 (configurable). Viz Mosart will set the looping from frame 12 to frame 444

- **CUE_TAIL**: Viz Mosart will recue the cued clip at a specific time (in seconds)
  - Parameter: -15 (negative value) - configurable. Viz Mosart will cue at the start of the last 15 seconds of the clip (the clip will have 15 seconds left to play plus Post roll)
  - Parameter: 15 (positive value) - configurable. Viz Mosart will cue 15 seconds into the clip

- **PLAY_TAIL**: Viz Mosart will recue and play the cued clip at a specific time (in seconds)
  - Parameter: -15 (negative value) - configurable. Viz Mosart will cue at the start of the last 15 seconds of the clip
• Parameter: 15 (positive value) - configurable. Viz Mosart will cue 15 seconds into the clip

Video Port Groups

It is also possible to use the video port group names (A/B, C/D...). If a group is found it will by default get the next port. If you want the current port you have to add “CURRENT” to the Parameter field. If you want to have additional parameters for the Action you can add it after the CURRENT term separated by comma.

Examples

In this example the cued port in the group will be recued to be ready to play the last 10 seconds of the clip.

```
VIDEO_PORT ▼
Action | CUE_TAIL
VideoPort | a/b
Parameter | -10
```

In this example the playing port will be paused.

```
VIDEO_PORT ▼
Action | PLAY_PAUSE
VideoPort | a/b
Parameter | CURRENT.PAUSE
```

Control On Air or Preview Video Port

It is also possible to make commands to control the video port that is currently on air or in preview. Just type ONAIR in the VideoPort field to direct the command to the on air port.

```
VIDEO_PORT ▼
Action | PLAY_PAUSE
VideoPort | ONAIR
Parameter |
```

To control the port in preview use PREVIEW in the VideoPort field.
In this example the video port in preview will recue to be ready to play the last 10 seconds of the clip.

Video Port Error Messages

If AV Automation is unable to execute the command an error message should be displayed, e.g. *Failed to get VIDEO_PORT using 'c/d'*

Configuring AV Automation Template Properties

The VIDEO_PORT control commands can also be used in templates. The syntax order of the parameter is important.

Here are some valid examples using port A:

- PLAY_PAUSE,A,PLAY_PAUSE,A,PAUSE PLAY_PAUSE,A
- STOP,A STOP,A,CUE RECUE,A,PLAY RECUE,A
- SET_LOOP,A SET_LOOP,A,OFF SET_LOOP,A,12-444 CUE_TAIL,A,-15 CUE_TAIL,A,15 PLAY_TAIL,A,-15 PLAY_TAIL,A,
2.9 Status Bar

The status and redundancy bar shows connection information for Viz Mosart servers and NCS, and contains shortcuts to redundancy features.

2.9.1 Left Hand Area

From left to right, these lights indicate connection status for the Main Viz Mosart server, the Backup Viz Mosart server (indicated by IP addresses) and the NCS. If a backup or "buddy" NCS is set up, another indicator light appears to the right of the main NCS.

- **Green**: Currently connected.
- **Red**: Not connected, in standby.
- **Grey**: Connection not set up/connection error. May also appear until the first rundown is loaded after a restart.

Clicking the Viz Mosart server currently in standby brings up a pop-up that makes it possible to switch Viz Mosart servers.

2.9.2 Right Hand Area

For graphics systems which support this, the graphics controller can be switched by clicking the Graphics Controller area.

If multiple video server salvoes are set up in AV Automation, the operator can switch between them by clicking the video server section on the menu bar. This dialog will appear and the user can select one of the video server salvoes.
The directtake last activated is indicated in the Directtake area.

In the far right hand corner of the GUI, the currently running Viz Mosart version number is shown. Clicking it also brings up a list of licenses for third-party components.

2.10 General Settings

The Tools > General settings > Settings menu contains important configuration parameters for the Viz Mosart GUI. These settings are localized.
Hover over a setting to see its description at the bottom of the window.

This section describes the following settings:

- Server
- User Interface
- Audio
- Miscellaneous

### 2.10.1 Server

The Server settings allow the user to configure which Viz Mosart servers the GUI is connected to. This option is normally not used after initial configuration.
Use the **Add** and **Remove** buttons to set up servers.

### 2.10.2 User Interface

This section describes:

- User Interface - General
- User Interface - Browse Mode
- User Interface - Storyline
- User Interface - Search Pool
- User Interface - Assets
- User Interface - Preview/Program Window
- User Interface - Keyboard
User Interface – General

- **Script filter** - Filters script text. Format 100,50 where first number is max.length at start and second number is max.length at end.
- **Disable story script autoscroll** - Disable the autoscroll functionality in the story script. This functionality keeps the current item at the top of the script window.
- **Disable rundown autoscroll** – Disable the autoscroll functionality in the rundown. This functionality keeps the view of the rundown in sync with the current story.
- **Hide big tooltips in rundown** – If this is checked, the big tooltip when you hover over an item in the rundown will no longer appear.
- **Untoggable standby devicelist** – A list of which devices should be locked from manually toggle standby status. Comma separated list, e.g. "Video server, audiomixer".
• **Reset autotake on reload** defines the behavior of the autotake mode on Reload (Default \texttt{SHIFT+F12}). When checked, Viz Mosart will revert to normal mode on reload.

• **Scroll into view count** defines how many story lines are auto scrolled into the GUI rundown window when running a show.

• **Show the connections menu** toggles the appearance of the Connections menu. In this menu, the Viz Mosart GUI can be connected to various control room server pairs, making it possible to use the same GUI to display/control several control rooms/studios.

• **Show rundown shortcut editor menu** toggles the appearance of the menu item Tools $\rightarrow$ Edit rundown shortcuts. See **Select Rundowns from the NCS** for details.

• **Show next item update** - When this is checked, a warning is displayed in the Preview window if the story in preview is updated from the NCS.

• **Show onair overlay graphics** - When this is checked, overlay graphics are displayed in the Program window when they go on air.

• **Confirm reload rundown commands** - When this is checked, a popup window asks for confirmation whenever a Reload Rundown command is issued by the user.

• **Show resync NCS message** - When this is checked, a popup window asks for confirmation whenever a rundown is locked and then unlocked again.

• **Show vertical timing grid bars** - When this is checked, horizontal lines will show to indicate time.

• **Use compact wall manager view** - When enabled the wall manager will only show the air canvas. The preview canvas and the salvo tools are hidden.

• **Use Crossover Control** – When enabled, the GUI will display the status of the Viz Mosart which is configured on the server.
User Interface – Browse Mode

The check boxes under the Browse Mode header make it possible to allow or disallow various actions whenever a Viz Mosart GUI is set to Browse Mode. By default, all are unchecked, rendering the Browse Mode GUI completely “safe”.

- **Enable switch graphic profile in browse mode** - Change graphics profile in browse mode.
- **Enable switch rundown in browse mode** - Change rundown in browse mode.
- **Enable set devices in standby in browse mode** - Change standby devices in browse mode.
- **Enable switch studio setup in browse mode** - Change studio setup in browse mode.
- **Disable autoscroll in browse mode** - Disable the autoscroll functionality in the rundown and in the script view in browse mode.
- **Enable edit buttons in browse mode** - Use the edit buttons in browse mode.
- **Enable editing of storyline in browse mode** - Edit storyline in browse mode.
- **Enable unfocused alert in browse mode** - When disabled the unfocused alert will not be shown in browse mode and the application will not have focus.
- **Enable browse option in menu** - Enables the appearance of the Show → Browse Mode menu item.
## User Interface – Storyline

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable client move story</td>
<td>Enables moving a story by right-clicking it in the rundown.</td>
</tr>
<tr>
<td>Count down to live story elements</td>
<td>Enables countdown to stories containing either a Live, DVE or Telephone template.</td>
</tr>
<tr>
<td>Auto scroll long story elements</td>
<td>When checked long stories will automatically be scrolled horizontally while the story item is played.</td>
</tr>
<tr>
<td>Graphic layer based on template type</td>
<td>Enables the use of Layer 2 and Layer 3 identification. i.e. <em>Layer 2 overlay graphics is identified by</em> and <em>Layer 3 overlay graphics is identified by</em>.</td>
</tr>
<tr>
<td>Toggle group stories feature</td>
<td>Group stories within story groups with the same prefix in the GUI. All items within each group is also shown in the asset window.</td>
</tr>
<tr>
<td>Number of visible aired timeline elements</td>
<td>Number of elements already aired that should be visible in a story while it is playing. Use -1 to show all.</td>
</tr>
<tr>
<td>Hide empty stories</td>
<td>Stories without items will not be shown in the rundown.</td>
</tr>
<tr>
<td>Ignore overlay graphics with keywords</td>
<td></td>
</tr>
<tr>
<td>Layer 2 overlay graphics is identified by</td>
<td></td>
</tr>
<tr>
<td>Layer 3 overlay graphics is identified by</td>
<td></td>
</tr>
<tr>
<td>Video clips should be presented with...</td>
<td><em>clip description or clip name</em></td>
</tr>
<tr>
<td>Show set as next break</td>
<td></td>
</tr>
<tr>
<td>Show Set As Next Story</td>
<td></td>
</tr>
<tr>
<td>Show Set As Next Story And Skip</td>
<td></td>
</tr>
<tr>
<td>Search pool</td>
<td></td>
</tr>
</tbody>
</table>
• **Ignore overlay graphics with keywords** - Overlay graphics connected with any Handler name input here are hidden in the GUI.

• **Layer 2 overlay graphics is identified by** Overlay graphics connected with any Handler name input here is displayed in the secondary overlay graphics layer.

• **Layer 3 overlay graphics is identified by** Overlay graphics connected with any Handler name input here is displayed in the tertiary overlay graphics layer.

• **Video clips should be presented with**... Select how you want video clips to be displayed to the user in the user interface from the drop-down list.

• **Show set as next break** - When this is checked, Set As Next Break is available as an option in the rundown context menu. Selecting this option will cause Viz Mosart to regard that story line as a Break line for countdown and timing purposes.

• **Show Set As Next Story** - When checked, Set As Next Story is available as an option in the rundown context menu. (Right click.) The user can jump to stories further up or further down in the rundown, independently of the NCS running order.

• **Show Set As Next Story And Skip** - When checked, the storyline context menu option *Set As Next Story And Skip* will be available.

User Interface – Search Pool

![User interface - Search Pool](image)
• **Default Float Variant** - This indicates the Float variant Viz Mosart will add to any video file found in the search window when dragged to the rundown, a shortcut key or the **Favorites Tab**. See below for information on the drag and drop feature.

• **Default Package Variant** - This indicates the Package variant Viz Mosart will add to any video file found in the search window when dragged to the rundown, a shortcut key or the **Favorites Tab**. See below for information on the drag and drop feature.

• **Default Voiceover Variant** - This indicates the Voiceover variant Viz Mosart will add to any video file found in the search window when dragged to the rundown, a shortcut key or the **Favorites Tab**. See below for information on the drag and drop feature.

• **Hide story name in Quick Access Tab** - The Quick Access Tab will show the filtered items as a list without any indication of the stories.

• **Media Search Column** - Values entered here define the format of search results displayed when searching the video servers. Values can either be entered without name tags, in the format: "slug, durationtc"

Or with name tags, in the format: "Name=slug, Dur=durationtc"

This tells Viz Mosart to display results with Name:xxx (found in the slug column on the server database) and Dur:xxx (found in the durationtc column on the server database). The resulting search window could look like this:

![Search Results Example](image)

• **Recue Items When Reaired** - When checked, previously played video items dragged from the Assets and Favorites Tabs into the rundown are recued.

• **Template type when drop + CTRL** - Entering Float, Package or Voiceover here will define which of the three types is connected to material dragged from the Search window when holding down the CTRL key.

• **Template type when dropping** - Typing Float, Package or Voiceover will define which of the three types is connected to material dragged from the Search window without holding down a key.

• **Template type when drop + SHIFT** - Typing Float, Package or Voiceover will define which of the three types is connected to material dragged from the Search window when holding down the SHIFT key.

• **Use Public Pools** - When checked, manually updated **Favorites Tabs** are shared between GUIs connected to the same server. A shared Favorites Tab is indicated by a small symbol in the top right hand corner of the tab.
User Interface – Assets

- **Asset Legend for XXX** Entering a value in this field defines the format displayed for assets in the Assets Tab, in the same way as with Media Search Column above. The syntax for defining the legend is shown in the Asset Legend Syntax section below. Valid parameters are listed in the Assets Properties list further down. The legends used in Asset window are customizable for all Viz Mosart template types shown in the table above. Legends for other template types will be shown using the corresponding slug.

- **Hide big tooltips in assets window** Normally when you hover over an item in the Asset window, a big tooltip appears with the full details of the item. If this is annoying, the tooltip can be disabled by checking this box.

- **Enable send item to preview when clicked** If this is checked, clicking on a primary item in the Asset window will immediately send it to preview, i.e. it will be inserted as the next item in
the story currently on air. (Note that if an item was unintentionally sent to preview in this
way, this can as always be undone by pressing Skip Next (default F9).

Asset Legend Syntax

Legends for template types in the asset window are defined as a set of properties divided by the ‘|’
character where each property has the following syntax:

\[[separator][[Title]]Property[[DefaultValue]\]

Where:

- [separator] – Optional separator to separate the property from its predecessor.
  Using a ‘^’ as the first character ensures that the first property this the following property.
  Otherwise all legends will start with the slug
- [[Title]] – Optional title. Need to be defined inside [] brackets
- Property – Named property, see table below
- [[DefaultValue]] – Optional default value. Need to be defined inside {} brackets

Note that in the syntax above [] is also used to denote optional content.

Examples:

1. MEDIACONTENT{[MISSING CONTENT]}, [Duration=]DURATION

   Will display Slug + Clip/Graphics description + clip duration. Description will be showing
   “[MISSING CONTENT]” if the template lacks content. Typically if no content is added in the
   NCS.

2. ^TEMPLATEVARIANT/ MEDIACONTENT{[MISSING CONTENT]}

   Will display template name + Clip/Graphics description. I.e. starts with template name

Assets properties

The list below shows the different template properties available for use in asset legends:

- CLIPDESCRIPTION: Normally clip slug (slug)
- CLIPHIRESPATH: Clip reference. Normally clip slug (clip_hirespath)
- CLIPREFID: Clip reference id. Normally clip server identity number (metadata_lookuppath)
- CONTINUECOUNT: Continue count for fullscreen graphics (continuecount)
- DESCRIPTION: Item's description (clip_hirespath)
- DURATION: Clip duration in mm:ss
- GRAPHICSDESCRIPTION: Graphics description. Normally name of fullscreen graphics
  (graphics_description)
- GRAPHICSID: Graphics id. Normally graphics id used by graphics system (graphics_id)
- ITEMIN: In-time in hh:mm:ss for secondary objects (like accessories and CGs)
- LEGEND: Equals SLUG if present. Otherwise set to DESCRIPTION
• **MEDIACONTENT**: Equals CLIPDESCRIPTION for clips and GRAPHICSDESCRIPTION for fullscreen graphics

• **SLUG**: Textual description of the element. Normally as entered in NCS (slug)

• **TEMPLATEVARIANT**: Template variant name (templatetype)

• **TRANSITION**: Transition given as [CUT|MIX|EFFECT](duration|effectno) (transitions(rate))

**Default Value**

The slug is implicitly used as the first value. This is the same as entering ^SLUG as the description. I.e. if the ‘^’ is not present as the first character then the slug will be used as the first value. To use other properties as the first value, the description should start with the ‘^’ character.

**User Interface – Preview/Program Window**

- **Show out word on floats** - These allow the user to define which Viz Mosart types should have the Last Words functionality. When checked, the last words in the script (or the last words defined through a command in the script, depending on NCS and Viz Mosart type) will be displayed in a black box in the GUI Program Window.
- **Show out word on CAM templates** - When checked, the last words in the script of CAMERA templates will be displayed in a black box in the GUI program window.
- **Show out word on PACKAGE templates** - When checked, the last words in the script of PACKAGE templates will be displayed in a black box in the GUI program window.
- **Show out word on VOICEOVER templates** - When checked, the last words in the script of VOICEOVER templates will be displayed in a black box in the GUI program window.
- **Clip visual countdown**: If this has a value above 0, the countdown of PACKAGE and VOICEOVER will change color to alert the user if the countdown reaches this value. See also [Timing Information](#) and [Countdown of Video Wall Elements](#).
- **Hide Mark In and Mark Out control** - Hides the Mark In and Mark Out selector.
- **Show out word on TELEPHONE templates** - When checked, the last words in the script of TELEPHONE templates will be displayed in a black box in the GUI program window.
- **Show out word on DVE templates** - When checked, the last words in the script of DVE templates will be displayed in a black box in the GUI program window.
- **Show out word on LIVE templates** - When checked, the last words in the script of LIVE templates will be displayed in a black box in the GUI program window.
- **Show out word on fullscreen graphics** - When checked, the last words in the script of fullscreen graphics templates will be displayed in a black box in the GUI program window.

### User Interface – Keyboard

<table>
<thead>
<tr>
<th>User interface</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
</tr>
<tr>
<td>Browse mode</td>
</tr>
<tr>
<td>Storyline</td>
</tr>
<tr>
<td>Search pool</td>
</tr>
<tr>
<td>Assets</td>
</tr>
<tr>
<td>Preview/Program window</td>
</tr>
<tr>
<td>Keyboard</td>
</tr>
</tbody>
</table>

- Fill manual lawfethirds only
- Import keyboard shortcuts on startup
- Save keyboard changes on exit
- Set last selected keyboard layout as default
- Show keyboard layout name
- Toggle use of extended keyboard keys
- Use public buttons
- **Fill manual lowerthirds only** - When checked, only NCS bound lowerthirds will fill keyboard shortcuts with manual lowerthird. When unchecked, all lowerthirds will fill any keyboard lowerthird.

- **Import keyboard shortcuts on startup** - When this setting is enabled the GUI will try to import keyboard settings from the server every time the GUI restarts. To export a keyboard settings file to the server select LAYOUT - EXPORT in the keyboard shortcuts window.

- **Save keyboard changes on exit** - When checked, all the changes to the keyboard layout like dropped keys etc. will be saved on exit.

- **Set last selected keyboard layout as default** - When this setting is enabled the last used keyboard layout will open the next time the GUI restarts

- **Show Keyboard Layout Name** toggles the appearance of the currently selected keyboard layout at the top of the keyboard shortcut section of the GUI.

- **Toggle use of extended keyboard keys** – When checked, some special keys like Enter/Return are treated differently. The extended variant is shown with an asterisk* in the keyboard editor.

- **Use Public Buttons** When this is checked, manually updated shortcut buttons are shared between GUs connected to the same server. A shared button is indicated by a small symbol in the top right-hand corner of the button.
2.10.3 Audio

- **Audio file directory** tells Viz Mosart where to find the audio countdown files. They must be in PCM WAV format (16 bit, 48 kHz), and follow this naming standard:
  - 60_sec
  - 30_sec
  - 10_sec
  - 5_4_3_2_1
  These are only examples; the Viz Mosart GUI countdown feature will accept and play any file on the format above. Thus, a file named 47_sec will be played when 47 seconds remain of a given event if that is desired.

For the countdown to next break feature, the naming standard is:
- 180_sec_Next_Break
- 120_sec_Next_Break
- 60_sec_Next_Break
- 30_sec_Next_Break
- 10_sec_Next_Break
- 5_4_3_2_1_Next_Break

- **Countdown to adlibpix\floats** - Toggles an audio countdown file to be played from the Viz Mosart GUI PC when 3 minutes, 2 minutes, 1 minute, 30, 10 and 5 seconds remain until an adlibpix\float element with server\video content

- **Countdown to breakline** - Toggles an audio countdown file to be played from the Viz Mosart GUI PC when 3 minutes, 2 minutes, 1 minute, 30, 10 and 5 seconds remain until a designated break line.
• **Countdown to server clips** - Toggles an audio countdown file to be played from the Viz Mosart GUI PC when 1 minute, 30, 10 and 5 seconds remain of package templates.

• **Audio countdown to all stories** – Toggles an audio countdown file to be played from the Viz Mosart GUI PC when 3 minute, 2 minutes, 1 minute, 30, 10 and 5 seconds remain until the next story.

• **Countdown to autostart rundown** - Toggles an audio countdown file to be played from the Viz Mosart GUI PC when 3 minute, 2 minutes, 1 minute, 30, 10 and 5 seconds remain until the rundown will autostart.

• **Countdown to Live Story End** - Toggles an audio countdown file to be played from the Viz Mosart GUI PC when 1 minute, 30, 10 and 5 seconds remain until the editorial duration end of a live story.

• **Countdown to Next Break** - Toggles an audio countdown file to be played from the Viz Mosart GUI PC when 3, 2 and 1 minute, as well as 30, 10 and 5 seconds remain until the next break.

• **Countdown to voiceover elements** - Toggles an audio countdown file to be played from the Viz Mosart GUI PC when 1 minute, 30, 10 and 5 seconds remain of voiceover templates.

• **Offset Audio Countdown to Next Break** - Defines an offset in seconds for the countdown to next break feature.

• **Use Audio countdown** – Play audio when counting down.

### 2.11 Arrange Rundowns

![Mosart - Arrange Rundowns](image)

In the Arrange Rundowns window, you can create or modify a rundown list which contains multiple rundowns. Changes can be made before going on-air or while on-air.

To **open** this window, go to main menu > Rundowns > Arrange.

The left-hand pane lists the **Mosart Active Rundowns**, while the right-hand pane lists the **Available Rundowns**. Drag items between the lists, or select an item and use the **Add/Remove** buttons. **Clear** will empty the **Active Rundowns** list. Reorder items in the _Active Rundowns _list using the **Move up** or **Move down** buttons.
When you press **Confirm**, the items in the _Mosart Active Rundowns _list will be visible in the GUI in the order you determined.

## 2.12 Managing Your Workspace

The Viz Mosart GUI is highly flexible and can be changed to suit the particular needs of the individual station/channel/show/operator. To modify the visual appearance and layout of the GUI, the Workspace Manager can be used. To add or modify keyboard shortcuts, the Keyboard Shortcut Editor is used.
2.12.1 Customizing the Layout

By accessing the View > Manage Workspaces menu, the layout of an instance of the Viz Mosart GUI can be customized. In the Workspace Manager, the various windows in the GUI can be removed or added by checking and unchecking selections in the Show menu. They can also be moved by changing the values in the Row/Row Span/Column/Column Span fields at the top of the window. This might be useful for an instance of the GUI which will only be used for monitoring purposes - items like the keyboard window and Assets/Search/Favorites Tabs can be removed to give more space to the rundown.

2.12.2 Resizing Elements

The various elements can also be resized by dragging their borders. Any given layout can be saved as a workspace, and can later be recalled through the Show menu or through a designated shortcut command.

2.12.3 Export/Import

To conveniently copy a given layout across several GUI installations, the Export/Import selections in the Workspaces menu can be used.

2.13 Robotic Cameras

This control shows the status for any robotic cameras configured in AV Automation.

When pressed, the robotic function for the selected camera will go to standby and toggle back out of standby when pressed again. The icons are green when active and orange when in standby.
2.14 Quick Access Panel

The Quick Access Panel (QAP) provides a compact view of the rundown content, and can be filtered to show only clips, or even just specific types of clips.

The Viz Mosart GUI provides several ways to control a newscast show. It will show a series of stories gathered from an NCS system. The rundown shows the rundown as it is planned by the Director. But the producer can divert from this plan by skipping stories or items in the rundown or bring in new elements. This is done by using keyboard shortcuts or by browsing through the rundown.

The purpose of the Quick Access Panel is to make it easier for the producer when producing a dynamic rundown. It can also be a convenient way for Co-Producers or Co-Pilots to add more content to a rundown while the Producer is running the show.

The Quick Access Panel control shows all the executable elements of the entire rundown as buttons grouped in the stories they originate from. It provides access to modifiable Story Filters, which the producer or co-pilot can use to find elements they want to add to a running rundown.
The Quick Access Panel can be operated from a second GUI or as a part of the main GUI. When using it as a secondary GUI, simply open another Viz Mosart GUI and create a new workspace. Make sure the new layout is saved. It can also be useful to create shortcuts to switch between workspaces.

This section contains the following topics:

- Story Item
- Command Mode
- Story Filters

2.14.1 Story Item

Story Control

The Quick Access Panel shows each story as a rectangular box. Within the story container each element and sub-element is shown as a button. The Story type is indicated in the header by using the template color of the type of story element. The type of the story is determined by the elements it contains. Beneath the story box the user can enter text by clicking “Notes”.

The story item is always displayed within a story. The background of the button indicates the template type. The heading indicates template variant. A white text and red background as the Template variant text indicates an Unavailable template. The transparent text shows the slug.

The Quick Access Panel and the button sizes were designed with touch capabilities in mind.

You can take items (e.g. lower third, accessories, sound elements) on air by clicking the button. The button will get a red border and will appear in the program window. Take it off air by clicking the button again. Notice that if the item has a fixed time it will go off air by itself.

⚠️ Note: Clicking an item that already has gone off air will put it back on air again.
Primary Elements

1. CAM: Camera
2. PACKAGE: Video
3. VO: Voice over
4. LIVE: Live element
5. GRAPHICS: Full screen graphic element
6. DVE: Butterfly/DVE
7. FLOAT

Secondary Elements

Secondary elements are shown with a gray background.

1. LOWERTHIRD
2. SOUND
3. ACCESSORY

Story Status

If a story is on air its frame becomes red with white fonts. The item that is on air also get a red frame.

When the story, or story item, has been on air it gets a denser color.
Timing Information

Timing information is shown on top of stories:

- Duration (normal): How long the story is planned to last
- Planned (on air): The same as duration
- Elapsed: How long the story has been on air
- Duration (off air): How long the story lasted

Quick Access Panel Context Menu

Right-click the heading of a Story and select from the context menu options:

- **Set as next**: this story will be set as next
- **Insert item**: inserts all visible items (except floats) in the current order after the running item in the current story. If the command mode is Air Mode the first item will be taken directly.
- **Insert all items**: inserts all items (except floats) in the story after the running item in the current story. If the command mode is Air Mode the first item will be taken directly.
- **Count down to**: starts counting down to the first visible item in the story.

2.14.2 Command Mode

The result of pressing the Quick Access Panel buttons in the list varies depending on which of the command mode buttons is active.

Sel – Select Mode

The item clicked will become the selected item. This item can then be sent to preview, program or wall by clicking the relevant control.
Prw – Preview Mode
The item clicked will be added to preview.

Prg – Program Mode
The item clicked will go directly on air.
If the user holds while clicking any of the boxed buttons, the boxed item will be sent-to-preview (as with the story items in the rundown).

2.14.3 Story Filters
An important part of the Quick Access Panel are the filters. By clicking on the different filters you can switch between various views. For example, you may have one for Cameras, one for Videos, one for Live and DVEs etc.
Add new filters by right-clicking and selecting Add. This is located to the right of the filter buttons if in Wrapped buttons view or below the filter buttons if in List Button View. Enter a name for the filter. Note that the first letter in the name is used as a key and must therefore be unique.
The Quick Access Tab shows the same filtered elements grouped in stories.

Filter Context Menu
- **Rename**: Change the name of the filter
- **Add**: Add another filter
- **Remove**: Remove this filter
- **Move Left**: Change the order of the filter left
- **Move Right**: Change the order of the filter right
- **Items (header)**: the filters below are applied to the items within each story.
• **Show template types**: Select which kind of template types that are visible when this filter is applied

• **Show items with status**: Select which statuses the visible items can have:
  - Valid, Invalid (missing content etc), Aired (has been on air), OnAir (currently on air), Other.

• **Show items with template status**: Select if items with Valid or Unavailable templates are allowed; or Both.

• **Add slug filter**: Adds a slug filter.

• **Delete slug filter**: Remove a slug filter by selecting from a list.

• **Show items created by GUI**: If you want to see elements added within the GUI check this option. If not, all elements added by the GUI operator will not be visible, only the NCS content will be shown.

• **Story (header)**: The filters below are applied to each story.

  • **Show story types**: Select which kind of story types that are visible when this filter is applied.

  • **Show story with status**: Select if items with the different statuses should be visible when this filter is applied.
    - Valid, Aired (has been on air), OnAir (currently on air), Preview (story is next), Other.

**Example Filters**

**Show Missing Clips and Graphics**: A filter to display the checkered clips or graphics in the rundown can be useful during a show to quickly verify if clips and graphics are available. It can also be very useful to add countdowns to these clips. The countdown will display how long until the clip has to be ready.

```
Example Filters
Show Missing Clips and Graphics: A filter to display the checkered clips or graphics in the rundown can be useful during a show to quickly verify if clips and graphics are available. It can also be very useful to add countdowns to these clips. The countdown will display how long until the clip has to be ready.
```

- Show template types > PACKAGE, VO, GRAPHICS
- Show items with status > Invalid

  The countdown shown in the upper right corner can be set by right clicking the story.

**Show Missing Templates**: The filters can also be used to display missing templates. By applying the filter **Show items with template status > Unavailable**, the producer (or anyone using a GUI) can quickly spot any elements missing a proper template.

**Show a Slug Filter**: If the NCS Stories are using a kind of naming convention it can be easy to create container stories. For instance all highlights from a soccer match can be added to a specific story. Then by applying the slug filter “SOCCER_HIGHLIGHTS*”, all of these clips become available to the producer very quickly without having to scroll up and down the rundown. This approach also works very well with **FLOATS** (Adlibs) - clips.
Show Valid Floats: If the producer wants to have valid floats in the current on air story readily available, this filter can be used.

- Show items with status > Valid
- Show template types > FLOAT
- Show items with template status > Valid
- Show story with status > On-air Story Items

2.15 Wall Manager

The Wall Manager control helps you control any wall elements or any other AUX devices using the Viz Mosart GUI. The wall manager is optimized to be used with a touch screen.

This section contains the following topics:

- Creating a Wall Shortcut Item in AV Automation
- Creating a Wall Shortcut
- Wall Manager User Interface
- Countdown of Video Wall Elements
- Direct Take Wall Shortcut
- Wall Salvo
- Video Clip Playout Use Cases

2.15.1 Creating a Wall Shortcut Item in AV Automation

When creating a wall shortcut item you have to create a new shortcut. But before you can do that you need to create a wall accessory in AV Automation. The accessory will merge with the taken template causing the signal to go to the wall. The accessory can contain settings for cross points, video server port, graphics engine and aux.
Creating the wall accessory template

The wall accessory template is created as a normal template in AV Automation. You can create a new accessory template with a variant name of for instance "wall2".

Switcher cross point

To change switcher crosspoints enable "Switcher crosspoint" in the Template Editor. The Switcher XPoints will appear. Here you can set the ME-step you want for the wall taken template. When the template is set to the wall item it will use this ME step instead of the one specified in the template.

Video server port

If a video clip is wall taken; another video server should be used. This can be changed in the accessory.
Make sure the video clips are available through this port.

AUX

The AUX is controlled by the template but should be added to the accessory template. The setting will be replaced by the wall taken template.

Graphics

To avoid conflict with other graphic elements you may want the wall to run on its own engine. This can be changed in the accessory. A wall taken graphic element will then use this engine.

2.15.2 Creating a Wall Shortcut

When we have one accessory for each wall we want to control we are ready to create some wall elements in the Viz Mosart GUI. The wall shortcut should be created using the Keyboard Editor available through the Viz Mosart GUI top menu **Tools > Settings > Keyboard Shortcuts**.

1. Click **Add new shortcut**.
2. Select Wall Buttons > Wall 1 (see **The Wall1 Shortcut**)
3. Select the accessory for the wall you want to control.

4. Type in a name for the wall. It is recommended that you call the wall shortcut the same as the accessory, but it is not mandatory.

5. If you are using several wall elements you have to drag and drop them in the wall canvas in the keyboard editor. Here you can arrange the wall items and make it easier to recognize the different elements during production.

6. When you have added all the wall items you want to use; save and close the editor.

2.15.3 Wall Manager User Interface

The wall manager provides a quick and easy way to send content (clips or graphics) to specific destinations in the studio, typically video monitors (walls).
Areas of the Wall Manager

In the top area (red) the on-air wall templates are shown. In the bottom preview area (yellow) the selected salvo is shown.

The TAKE SALVO button is used to take the wall items in the preview area on air. It is also possible to take templates directly on air without using the salvoes.

During a show you can change templates on preset video wall salvoes by selecting a salvo and then pressing Take Salvo.

Compact View or Salvo View

The wall manager can be viewed in the GUI in either Compact view or Salvo view. To change the setting, go to User interface > General > Use compact wall manager view.

In Compact mode, the wall manager only shows the on air salvo section. This view works well when placed above the Quick Access Panel and/or Media Pool, so you can drag elements from the Media Pool or select an item in the Quick Access Panel and tap a wall item to execute the template.
The Wall1 Shortcut

A wall item in Viz Mosart GUI is defined as a shortcut of type **Wall1**. This item can be modified very quickly and taken on air using a Direct Take Wall Shortcut or a Wall Salvo.

Layout of Wall Items

The layout of the wall items can be set in the keyboard editor. But it is also possible to change the layout in the UI control. If you open the context menu of the Preview Salvo header.

The canvas will then change background color and go into **Edit mode**. While in this mode it is possible to drag the wall items around. When you are finished you must click the “Edit mode” button in the upper right corner to exit this mode. The canvas will then be ready again.
2.15.4 Countdown of Video Wall Elements

If a video clip is played on a wall using the methods mentioned above, the wall manager will display a countdown of the clip in the element in the on air canvas. When the video clip is Stopped, the countdown square is not shown.

For example, the image below shows a clip with a duration of 12 seconds, and 4 seconds left.

The clip can be controlled by sending control commands from the GUI with some parameters. When the clip is taken on a wall item it will be cued and played. Therefore the countdown will start immediately. By using the Video Port Control Commands the clip can be paused, stopped, recued and several more operations.

The Video Wall countdown states are as follows:

1. Playing
2. Cued
3. Paused
4. Playing but time remaining is low (the value is specified in Settings > User Interface - Preview/Program Window > Clip visual countdown)
5. Playing and Looping
6. Cued and ready to begin looping
7. Paused while looping

Post Roll Frames

The media administrator has post roll frames, which will not be used when counting down. For example, if a post roll of 75 frames is used, then there will still be 3 seconds left of the clip. Set the Post roll frames to 0 if you want to see the actual countdown.

2.15.5 Direct Take Wall Shortcut

A Direct take wall shortcut allows you to take a template directly on air on a wall very quickly and easily.

Direct Take Wall shortcut using a Keyboard shortcut

1. Select a selectable keyboard shortcut. (It will be highlighted in the keyboard buttons panel)
2. Select the wall element to take on air

Direct Take Wall shortcut using Quick Access Panel

1. Make sure the Quick Access Panel Command Mode is Sel - Select Mode.
2. Select a Story Item

3. Select the wall element to take on air

Direct Take Wall by dragging from Media Pool

Any item from the Media Pool can be dragged and dropped directly on a wall item. This also applies for video clips found by using the Search Tab functionality. The clips will then use the template as defined in User interface > Search pool > General Settings.
2.15.6 Wall Salvo

A wall salvo is a set of templates that will be sent to some wall elements. When taking a wall salvo all the wall items in the salvo will be taken on air. The Wall Manager UI encourages the use of wall salvos when working with wall elements.

Add a Wall Salvo

To add a new wall salvo click the New button, then type in a name of the salvo and press OK. You also have the option to Remove or Rename the selected/previewing salvo.

Fill a Wall Salvo

To fill a wall salvo with items with templates use a procedure similar to that for Direct Take Wall Shortcut, except that you click the wall items in the preview canvas instead of the items in the on air canvas, as follows:

Fill Wall Salvo Shortcut Using a Keyboard shortcut

1. Select a selectable keyboard shortcut. (It will be highlighted in the keyboard buttons panel)
2. Select the wall element to fill in the preview canvas

Fill Wall Salvo Shortcut using Quick Access Panel

1. Make sure the Quick Access Panel control is in Sel - Select Mode
2. Select a Story Item
3. Select the wall element to be filled in the preview canvas

Clearing Existing Wall Salvo Items

To remove a wall item from the preview canvas you can select another item from the keyboard buttons or Quick Access Panel and click the wall item you wish to replace.

To clear a wall item you can open the context menu and select "Clear".
Send Items to Wall using Quick Access Tab

1. Select the item you want to send to wall using the QUICKEVENT commands. The Quick Access Tab (QAT) can be used with the QUICKEVENT Control Command TAKE_SELECTED_TO_WALL. If you want to use the selected preview wall salvo then use the PREVIEW_SELECTED_TO_WALL control command.

2. Click the keyboard button with the defined shortcut with the QUICKEVENT variant TAKE_SELECTED_TO_WALL and the name of the accessory used by the wall item as the parameter.

It is also possible to drag and drop items from the Media Pool to any wall.
2.15.7 Video Clip Playout Use Cases

Independent Video Port Control
To play cover pictures from independent video ports, so that the director can choose to air these clips across live events, studio discussions or as-live clips, use the .Wall Manager v3.8.1, as well as Quick Access Panel.

Combining Quick Access Panel and Wall Manager for video clip playout
Together they become a “clip router” – enabling the operator to select any clip from the Quick Access Panel and send it to cue and play in the port of their choice.

If available, the Quick Access Panel and Wall Manager can be set up on a touch screen – making it even more user friendly.

With this configured it is now possible to manually assign clips to play in these four ports simultaneously - outside the timeline of Viz Mosart. As long as the selected mode in Quick Access Panel is Sel - Select Mode. These routings will be entirely independent of the A/B roll. Ensuring that the primary clips will not be interrupted by the playout of cover pictures.

In the example below, the LVO clip "A30" has been sent to play in Server Port C.
2.16 Recording

The Recording panel is used to prepare a new recording. Enter the file/recording name and press Add (+).

To open this window, go to main menu > Tools > Record.

⚠️ **Note:** The Recording window is only available if AV Automation has been configured to allow recording. See the section ‘Virtual Server Ports’ in the *Viz Mosart Administrator’s Guide.*
3 Operation

This section describes the following useful operations that can be performed using Viz Mosart.

- Quick Overview
- Select Rundowns from the NCS
- Initialize rundown
- Running the rundown
- Skipping a story element
- Current story
- Set as Next Story
- Running story elements out of story sequence
- Count down to a selected story
- Using direct take templates
- Pretake next overlay
- Looping part of the rundown
- Lock rundown or story
- Rehearsal and on air mode
- Creating sequences
- Adding stories to the rundown
- Changing template sets
- Changing graphic profiles
- Standby equipment from the GUI
- Running Viz Mosart in browse mode

3.1 Quick Overview

- Viz Mosart controls the devices in the control room that previously were operated manually. One person for the vision mixer, one person at the audio mixer, one person playing video tapes (from tape machines) etc.
- Now, Viz Mosart communicates with all of them: sending commands to the vision mixer to go from a camera to a video clip for instance.
- Sending a command at the same time to the audio mixer: "Pull the studio microphone faders down (belonging to the camera template) AND pull the video server faders up"! (Belonging to the video clip template)
- This will take away the sound from the studio (news presenters) (Camera), and enable the sound from the video servers only (hearing the audio from the video clip)
- And these commands that are doing all the things that you want to be done, are e.g. commands that you type in/drag into your story in the newsroom system (NRCS) E.g. iNEWS.
- So a journalist writing a story, can quickly (inside the NRCS) create a ready-to-air news story containing the Viz Mosart templates for e.g. Camera and Package (video clip.)
- And then for the Viz Mosart operator, when hitting Take Next on the PC keyboard, it performs the commands you have put into the story in the NRCS.
- The Viz Mosart GUI continuously receives updates from the NRCS. Not the other way around.
3.2 Select Rundowns From The NCS

Select the rundown you want to use from the Rundowns dropdown menu.

3.2.1 iNews Rundowns

To add iNews rundowns, go to the Tools menu and select Edit rundown shortcuts. All iNews rundowns must be manually added here.

⚠️ **Note:** The Edit rundown shortcuts menu is only available if Show rundown shortcut editor menu in Tools > General Settings > User Interface > General, is selected.
3.2.2 MOS Activated Rundowns

The rundown menu Rundowns > NCS active contains the rundowns sent to Viz Mosart from the NCS. The selected rundown(s) are highlighted with orange.

A special, predefined rundown is the `readytoair` rundown. This menu entry will select all rundowns with the status `Ready to Air` and append them based on the editorial start time. All new rundowns connected to Viz Mosart and set to the ready to air status will be inserted or appended based on the start time.

To show and run a specific rundown select the entry from the Rundowns > NCS active menu. Selecting a rundown from this menu is equivalent to using **SHIFT+F12** to reload the rundown.

3.3 Initialize Rundown

The rundown is initialized by using the **RELOAD RUNDOWN** command. This can be mapped to any keyboard button (default: **SHIFT+F12**). This will reset the status for all stories and story elements and cue the first element in the first story in program, and the second element in preview. Any changes made to the rundown in the GUI are replaced by the latest NCS data.
3.4 Running The Rundown

The TAKE_NEXT command can also be mapped to any key (default F12) and will either start the rundown or move to the next story element. If the current element is the last element in a story, the TAKE_NEXT command will take the first element in the next story. When the rundown is running, the current play position within the on-air template is indicated by a red play marker.

3.5 Skipping A Story Element

The next story element can be skipped with the SKIP NEXT command (default F9), making them disappear from the GUI. The element following the skipped element will then be cued in preview. Skipped element actions can be reversed with the UN-SKIP NEXT command (Default: SHIFT+F9), making them reappear in reverse order. Once you have progressed beyond the skipped item in the running order it is no longer possible to bring it back with UN_SKIP NEXT.

3.6 Current Story

The current story is highlighted with a red background in the info area. The left hand time is the time the story went on air. The middle counter indicates how long the story has been on air. The right hand timer shows the editorial duration given for the story.

3.7 Set As Next Story

The operator can jump to any story in the rundown by right clicking the mouse over the info area of that story and selecting **Set as next story**. The story set as next will be highlighted with yellow background in the info area.

If the rundown/timeline has not been started, then the selected item will be set as the first story.
3.8 Running Story Elements Out Of Story Sequence

Secondary story elements and some primary story elements can be right clicked in the Assets or Favorites Tab and taken to air or cued in preview.

3.9 Count Down To A Selected Story

By right clicking over the info area of a story and selecting Countdown from the menu, a countdown clock with minutes and seconds to the selected story's estimated on air time will appear in the middle of the info area.

3.10 Using Direct Take Templates

Direct take templates are recalled from the numeric keypad. Enter the number of the direct take template, and use the "-" key on the NumPad to take. The number entered is displayed in yellow in the lower right hand corner of the GUI.

3.11 Pretake Next Overlay

To pretake an overlay item in the next story element use an assigned shortcut (Default **CTRL+O**). This could be used to load a complex graphics item on the wall during a package. This would avoid any load-related delay in rendering graphics on air which might occur if the Cue and Play commands are sent simultaneously. The first overlay with time code equal 0 will be taken. See **Keyboard Shortcuts** for more information on shortcut setup.
3.12 Looping Part Of The Rundown

To loop a part of the rundown you can set the loop in/out by right clicking on the items you want to loop and select **Loop Start** or **Loop End**. The *start* and *end* of the loop are displayed by *two white dots*. To remove the loop, select **Loop Clear**.

When entering the first item in a loop Viz Mosart will go into auto-take next mode. Auto-take means that Viz Mosart will automatically take the next element in a rundown. Normally the operator will have to manually take the next element.

3.13 Lock Rundown Or Story

During a show it is possible to choose Lock Rundown from the Rundown menu. This will stop Viz Mosart receiving updates from the connected NCS and run from a locally cached copy of the rundown. To open the connection again, choose Unlock Rundown. Unlocking the rundown will immediately synchronize the current Viz Mosart rundown to the corresponding NCS rundown.

It is also possible to lock individual stories in the rundown. Right click on the selected story and choose Lock Story from NCS Update.

Repeat the procedure to unlock a locked story.
3.14 Rehearsal And On Air Mode

To disable Viz Mosart sending the running element status to the NCS, enable the Rehearsal mode by choosing the Rehearsal option from the Rundown menu. A rehearsal indicator is showed next to the Viz Mosart logo.

Switch back to *On Air* mode by clicking the Rehearsal option again.
3.15 Creating Sequences

By right clicking on the info area of a story and selecting Edit -> Save story as sequence, a story with all its templates and sub elements can be saved as a sequence. This sequence can later be used in template creation. Please note that a sequence can only be used in the template set in which it was created.

3.16 Adding Stories To The Rundown

By right clicking on the info area and selecting Edit > Insert Story, you can insert a new story-line. Content can then be dragged into the new story from the Assets and Favorites Tab, or inserted using the QuickEditor.

In addition you can also remove a story, add new items into a story, change the selected story as well as removing templates from a story.

Note: If story is locked with Lock Story from NCS Update, reload of the rundown (SHIFT+F12) will delete the new story. Only "Lock Rundown" from menu Rundowns will prevent deletion of the new story when reloading.
3.17 Changing Template Sets

The currently loaded template set in AV Automation can be changed directly from the Viz Mosart GUI. To do so, use the Studio Setups menu and select the desired template set from the pull-down menu.

3.18 Changing Graphic Profiles

The currently loaded graphic profile in Trio Interface/Overlay Graphics Interface can be changed directly from the Viz Mosart GUI. To do so, use the Graphics Profiles menu and select the desired graphic profile from the pull-down menu.

3.19 Standby Equipment From The GUI

It is possible to standby equipment from the Viz Mosart GUI. To do so, use the Standby dropdown menu to select the desired device. Doing this means that all Viz Mosart commands to that equipment are disabled until they are selected from this menu again, or the AV Automation is restarted.

The colours in the menu have the following significance:

- **Green** = Connected
- **Red** = Disconnected
- **Orange** = Standby
Whenever any device is put in Standby, the dropdown menu header is highlighted in orange to remind the operator that some equipment is in Standby mode. If a device is disconnected, the header is red, and this takes precedence over orange Standby status.

3.20 Running Viz Mosart In Browse Mode

Any Viz Mosart GUI can be put into browse mode.

To activate or deactivate Browse mode in a GUI, select Show -> BrowseMode.

When a GUI is in browse mode, its user is only able to browse the rundown and click on stories to view their contents in the Script and Assets windows. All actions and shortcuts affecting the rundown or connected equipment are disabled. The Browse Mode menu item can also be removed from the drop down menu.
4 Templates

This section contains the following topics:

- Template Editor
- Building Viz Mosart Templates
- Template Device Functions
- Additional Template Functionality
- Template Examples
- AutoTake Timing

4.1 Template Editor

The Template Editor is accessed from the AV Automation application. Go to Main menu > Devices > Template editor.

For more information about AV Automation see the Viz Mosart Administrator’s Guide.

4.2 Building Viz Mosart Templates

This section contains the following topics:

- Editing Template Sets
- Editing Templates
- Editing Device Functions
4.2.1 Editing Template Sets

Adding Template Sets
New template sets are added by selecting File->New template set. Enter the name of the new set in the text box and select OK.

Opening Template Sets
Existing template sets can be selected from the menu File->Open template set. The name of the currently opened set is shown at the top of the Template Editor.

Renaming Template Sets
Template sets can be renamed from the File->Rename template set. Enter the new name in the text box and select OK.

Deleting Template Sets
Template sets are deleted by selecting Edit->Remove template set. A dialog box will ask you to confirm this.

Copying Template Sets
Copy a template set by selecting Edit->Copy template set. Enter the name of the new set in the text box and select OK. This will copy the template set including all containing templates.

4.2.2 Editing Templates

Adding a Template
Add a new template to the currently selected template set by selecting File->New template. Please enter the properties of the new template according to the table below

Template Properties

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the template. This value will only show in log files. English language is preferred, for making it easier to understand log-files.</td>
</tr>
<tr>
<td>Item</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Type</td>
<td>The different types are described in <a href="#">Primary Story Elements</a> and <a href="#">Secondary Story Elements</a>.</td>
</tr>
<tr>
<td>Variant</td>
<td>The variant is a unique name for the selected type, and should match the value entered in the newsroom system.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the template (optional). English language is preferred.</td>
</tr>
<tr>
<td>Recall Nr (Direct take)</td>
<td>The Recall Nr value only applies for templates in the Direct takes template set. Values from 0-999 apply, and are the value recalled from the numeric keypad in the Viz Mosart client application. Note: Avoid starting numbers with ‘0’, i.e. use ‘56’ instead of ‘056’.</td>
</tr>
<tr>
<td>Default NCS variant</td>
<td>This sets the template as the default variant for the selected type.</td>
</tr>
<tr>
<td>Send to NCS</td>
<td>Tick this box to allow this template to show up in the NRCS ActiveX.</td>
</tr>
<tr>
<td>Preload</td>
<td>Only valid for Accessory templates. Check the box to enable the preview functionality for the Accessory template. The Accessory template must have time code 00:00 for this to function.</td>
</tr>
<tr>
<td>Autotake</td>
<td>Enable this check box to automatically do a <strong>F12</strong> (Viz Mosart continue) at the end of the templates duration.</td>
</tr>
<tr>
<td>Offset</td>
<td>Set the offset when Autotake is enabled to adjust the Viz Mosart continue action at the end of the event. The value is in frames. Negative values are allowed.</td>
</tr>
<tr>
<td>Fixed Duration</td>
<td>If you want the template to always have the same length (override the time from the NCS) in the Viz Mosart rundown, then activate Fixed Duration, and enter the time in mm:ss:ff (minutes:seconds:frames). This can also be combined with Autotake to make a frame accurate continue to the next story. Remember to write the whole number each time, you cannot edit a single character at a time.</td>
</tr>
<tr>
<td>Sub Sequence</td>
<td>Please refer to <a href="#">Creating sequences</a> for details.</td>
</tr>
<tr>
<td>Hide from user</td>
<td>Check the box to remove this template from the template list in the Quick Editor.</td>
</tr>
<tr>
<td>Item</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Use state variant s</td>
<td>Please refer to Additional Template Functionality for explanation of State variants.</td>
</tr>
<tr>
<td>Control Commands (tab)</td>
<td>If the template should have Control Commands attached, this should be configured here. Please refer to Control Commands in Templates for further instructions.</td>
</tr>
<tr>
<td>Pretake</td>
<td>With pretake ticked, the whole accessory template triggers in preview. Pretake requires accessory template to have preload enabled and also primary type to trigger pretake defined (only for accessories with in-time=0).</td>
</tr>
</tbody>
</table>

Editing a Template

Edit the template properties by selecting Edit->Template properties. Template properties can also be accessed by a right-click in the devices function area. Please refer to Adding templates for a description of the properties.

Deleting a Template

Remove the current selected template by selecting File > Remove template. A dialog box will ask you to confirm this.

Copying a Template

To copy a template from one template set to another template set follow this procedure: Open the template you want to copy. Select Edit->Copy template. Switch to the other template set, and then apply Edit->Paste template. Select Edit->Paste to all, to copy the template to all template sets.

4.2.3 Editing Device Functions

Enabling Device Functions

Enable a device function by right clicking in the Device function area. Select the device to configure from the Enable menu. This will open the edit box for the selected device. Please refer to the Template device functions for a list of properties for each device.
Editing Device Functions

Edit a device’s properties by right clicking over the top half of a Device in the device function area and select Device properties. Please refer to the Template device functions for a list of properties for each device.

Removing Device Functions

Disable device function by de-selecting it from the Enable menu when right clicking over the Device function area.

Linking Device Properties and Newsroom Tags

To make a device property editable from the newsroom system, right click over the property and select Add newsroom tag. The property will then be reassigned to the value supplied from the newsroom system. If several device properties are given a newsroom tag with the same name in a template, all devices will use the value given in the newsroom system.

4.3 Template Device Functions

This section contains the following topics:
4.3.1 Video Switcher Crosspoint

The video switcher crosspoint enables switching on the video switcher. The A or B bus assignment of the mixer effect (PP/MEx) is automatically handled by the automation.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Crosspoint</td>
<td>Crosspoint on the video switcher. <strong>Note:</strong> Newsroom tag available. <strong>Note:</strong> The actual source isn’t selected until you click ‘OK’ and the dropdown listing available x-points appears.</td>
</tr>
<tr>
<td>Item</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Mix Effect</td>
<td>Selects which ME bank on your vision mixer you are working on. Available values Program (PP), ME1, ME2, ME3, ME4. <strong>Note:</strong> Newsroom tag available.</td>
</tr>
<tr>
<td>Crosspoint PP</td>
<td>If another Mix Effect (ME) than PP is chosen, then you can select a crosspoint for program by writing the crosspoint name in the field.</td>
</tr>
<tr>
<td>Set ME in PP</td>
<td>If another ME than PP is chosen, check this box to make that ME the crosspoint for PP. (Checking this box will disable XPOINT PP).</td>
</tr>
<tr>
<td>Crosspoint Hold</td>
<td>Keeps the crosspoint on the selected Mix/Effect.</td>
</tr>
<tr>
<td>Mix Delay</td>
<td>Offset in frames to when to perform the transition.</td>
</tr>
<tr>
<td>Mix Delay Out</td>
<td>Delay in frames to when to perform the next transition.</td>
</tr>
<tr>
<td>Transition Only</td>
<td>Only delay the switcher transition (sub items will perform).</td>
</tr>
<tr>
<td>DSK Off</td>
<td>Downstream keyer off. Turns off the DSK on the video switcher when the template is active in program. The keyer selected as DSK in the switcher device property (Devices - Properties - Vision Mixer), will be used.</td>
</tr>
<tr>
<td>DSK 2-4 On</td>
<td>Downstream keyer 2-4 on. Turns on DSK 2-4 (PP key 2-4) on the video switcher when the template is active in program.</td>
</tr>
<tr>
<td>Off delay</td>
<td>Delay in frames to set the DSK 2-4 off.</td>
</tr>
</tbody>
</table>

**4.3.2 Video Switcher Transition**

The transition device is only available when Video switcher crosspoint is enabled. Click on the entry to cycle through the transition types; mix, wipe and effect. Enter the default duration for the mix and wipe transition, or the effect name for the effect transition.
The transition will be performed with the auto transition functionality in the video switcher. To do a cut use a MIX transition with 0 frames duration.

It is possible to disable the transition by right clicking over the device and then choose Disable. To add a mixdelay, a value in frames can be entered in the same property window. Adding a mixdelay will delay the start of the transition, compared to other device commands, when the template goes on-air.

4.3.3 Video Switcher Register/Timeline Recall

Video switcher register/timeline recall (Emem Recall) enables recall of a register and/or timeline in the video switcher.

**Note:** If the register recall is used in pair with the video switcher key bus delegation and/or auxiliary bus delegation, the key/aux bus delegation should be disabled in the video switcher register to prevent the conflict between the stored delegation and the Viz Mosart assigned delegation.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>NAME</td>
<td>Name of register/timeline.</td>
</tr>
<tr>
<td>DESCRIPTION</td>
<td>Description of register/timeline.</td>
</tr>
<tr>
<td>MIXFFECT</td>
<td>Select the ME from where the register/timeline should be recalled. Available static values are Program (PP), ME1, ME2, ME3, ME4 and DEFAULT (Master). To dynamically choose ME1 or ME2, values M_RIP and M_OTH are available. <strong>Note:</strong> Newsroom tag available</td>
</tr>
<tr>
<td>EMEMNR PREVIEW</td>
<td>Register/timeline to be recalled when the template is cued in preview.</td>
</tr>
<tr>
<td>EMEMNR PROGRAM</td>
<td>Register/timeline to be recalled when the template is taken to program.</td>
</tr>
<tr>
<td>LOAD TIME</td>
<td>Enter a value in frames for adding a delay from when the mixer register is activated (in program or preview), to the rest of the template should be executed.</td>
</tr>
<tr>
<td>Item</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>OPEN VS FADER</td>
<td>If checked, Viz Mosart will open the fader inserted in the &quot;Audio effect server&quot; placed in the Audio tab in Device Properties in AV Automation.</td>
</tr>
</tbody>
</table>

### 4.3.4 Video switcher key bus delegation (Keyfill)

Video switcher key bus delegation enables routing of internal video switcher signals to the keyers on the different mixer effects on the switcher.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BUS</td>
<td>Selects the key bus on the selected ME. <strong>Note:</strong> Newsroom tag available</td>
</tr>
<tr>
<td>XPOINT</td>
<td>Crosspoint on the video switcher. <strong>Note:</strong> Newsroom tag available</td>
</tr>
<tr>
<td>AUDIOLINK</td>
<td>Assigns a link group to this delegation. Please refer to Linking video and audio sources for the use of this feature.</td>
</tr>
<tr>
<td>MIXEFFECT</td>
<td>Select the ME where the key crosspoint should be set. Available values PP, ME1, ME2, ME3, ME4. <strong>Note:</strong> Newsroom tag available</td>
</tr>
<tr>
<td>KEY SET DELAY</td>
<td>Set the delay in frames of the key delegation when taking the template to program. If the field is left blank the key is set in preview.</td>
</tr>
<tr>
<td>KEY ENABLE</td>
<td>Ignore, On, Off. <strong>Note:</strong> Newsroom tag available</td>
</tr>
</tbody>
</table>

### 4.3.5 Video switcher auxiliary bus delegation

Auxiliary bus delegation enables routing of internal video switcher signals to the auxiliary outputs of your video switcher.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BUS</td>
<td>Selects the auxiliary to assign a new source. <strong>Note:</strong> Newsroom tag available</td>
</tr>
<tr>
<td>XPOINT</td>
<td>Crosspoint on the video switcher. <strong>Note:</strong> Newsroom tag available</td>
</tr>
</tbody>
</table>
### 4.3.6 Graphics

The graphics device enables recall of graphic elements. Graphic elements will be cued (loaded) in preview and played (started) when taken to program.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AUDIOLINK</td>
<td>Assigns a link group to this delegation. Please refer to Linking video and audio sources for the use of this feature.</td>
</tr>
<tr>
<td>SET DELAY</td>
<td>Set the delay in frames of the key delegation when taking the template to program. If the field is left blank, the key is set in preview.</td>
</tr>
<tr>
<td>TRANS DUR</td>
<td>If the vision mixer has the ability to mix on the AUX channels, this is where the mix rate is set, 0 is a cut.</td>
</tr>
</tbody>
</table>

##### Engine
- Select the engine to operate on when using this template based on your configuration

##### Content Source
- **Dataconnection**: use content from the attached graphics database.
- **Newsroom**: use content from the attached NCS.
- **None**: use content written into the template

##### Scene Name
- The default scene name will be used if not overridden by the NCS. **Note**: Newsroom tag available

##### Scene Text
- The default scene text will be used if not overridden by the NCS. **Note**: Newsroom tag available
Send Continue on DVE FORWARD | If checked, a continue command will be sent together with a DVE Forward command.

Use VizPilot | Enable to run this element through a Viz Pilot client. This will allow for OnLiveUpdate events in Viz Pilot data elements.

Use take Out Command | If checked, a take out command will be sent when the template status changes from onair to offair.

Take Out Delay | Delay of sending takeout command after template status changes from on-air to off-air.

### 4.3.7 Robotic Camera Control

The camera control device allows for recalling camera shots (and preprogrammed moves) when the template is cued in preview or aired in program. The device editor supports salvo recalls of shots by adding multiple lines for each shot recall.

The **Standard Robotic Camera Control Properties** are described below, as well as exceptions for specific camera types:

- Standard Robotic Camera Control Properties
- Cambotics Properties
- Camerobot Properties
- Cinneo System Properties
- Fx-Motion Properties
- Panasonic Properties
- Technodolly Properties
- Shotoku TR_T Properties
- Telemetrics Properties
- Vinten 200 Properties
- Electric Friends Robotic Camera

**Standard Robotic Camera Control Properties**
- **Shot Name**: Name of the shot
- **Camera Number**:
  - -1: Shot is sent to all cameras not in standby
  - >=0: Shot is sent to camera with same number
- **Page Preview**: For recalling a shot/move when the template is cued in preview.
- **Preset Preview**: For recalling a shot/move when the template is cued in preview.
• **Time preview**: Time to shot’s position in preview.
• **Delay preview**: Recommended not used, can be deprecated in future versions. Delay of move when cued in preview (frames).
• **Page program**: For recalling a shot/move when the template is aired in program. See *Page Preview* for explanation.
• **Preset program**: For recalling a shot/move when the template is aired in program. See *Preset Preview* for explanation.
• **Fade time Program**: Time to shot’s position in program. See *Time preview*.
• **Delay program**: Delay of move in program (frames). Only available for Radamec robotics systems.
• **Protect on air source**: Protected video switcher cross-point. If the video switcher cross-point is on air, the shot/move recall will be ignored. This protection may, by configuration for some robots, be confined to preview and/or program, and to cuts and/or moves.

### Cambotics Properties

- **Camera Number**: Set camera number to 1
- **Page Preview/ Page program**: Robotic camera number
- **Preset Preview/ Preset program**: Shot number
- **Time preview/ Fade time Program**: [Optional] Duration for move in deciseconds (10 deciseconds = 1 second).

⚠️ **Note**: For Cambotics, all parameters not defined specifically, must be set to -1.

### Camerobot Properties

- **Page Preview/ Page program**: Name of shot’s matrix in preview/program
- **Preset Preview/ Preset program**: Shot’s cell number in the selected matrix - shot is adjustable from NCS and GUI
- **Time preview/ Fade time Program**: 0 ~ cut (fastest move) to position, ?0 ~ programmed move speed (adjustable from NCS and GUI)

### Cinneo System Properties

- **Page Preview/ Page program**: Name of camera to recall
- **Preset Preview/ Preset program**: Name of shot to recall - adjustable from NCS/GUI
- **Time preview/ Fade time Program**: Wanted moving time (seconds)

### Fx-Motion Properties

- **Page Preview/ Page program**: Identifies the camera to recall (identical to *Camera Number* > 0), optionally followed by :category for temporary overriding any NCS or GUI settings
- **Preset Preview/ Preset program**: Name of shot or move to recall
• **Time preview/ Fade time Program**: =0 cut, <0 ~ default time to shot, >0 ~ wanted time (frames)

Panasonic Properties

• **Camera Number**: Identifies the Controller that the command is linked to
• **Page Preview/ Page program**: Identifies the Camera Number to be controlled in preview/program
• **Preset Preview/ Preset program**: Identifies the Preset Stored Move in preview/program
• **Time preview/ Fade time Program**: Sets the Timed Delay in preview/program
• **Delay preview**: Not in use
• **Delay program**: Not in use

Technodolly Properties

• **Page Preview/ Page program**: Identifies the camera, identical to *Camera Number* when >0
• **Preset Preview/ Preset program**: Name of move to recall
• **Time preview/ Fade time Program**: =0 ~ go to start of move, ?0 ~ move

Shotoku TR_T Properties

• **Page Preview/ Page program**: Page of shot to recall

Telemetrics Properties

• **Page Preview/ Page program**: Preset page number to recall
• **Preset Preview/ Preset program**: Preset number to recall
• **Time preview/ Fade time Program**: =0 cut, <0 ~ default time to shot, >0 ~ wanted time (seconds).

Vinten 200 Properties

• **Page Preview/ Page program**: Name of show to recall
• **Preset Preview/ Preset program**: Name of shot or move to recall
• **Time preview**: <0 ~ go to end position of a move, = 0 ~ cut to shot, >0 ~ go to start position of a move, or move to a shot (frames)
• **Fade time Program**: For moves, move forward or backward according to *Time preview*. For shots, = 0 ~ cut to shot, ?0 ~ move to shot (frames).

Electric Friends Robotic Camera

For preview use:

• **Page Preview**: Show and Robotic camera name separated with a colon. E.g.: “ShowName:Cam 1”
• **Preset Preview** [Optional]: Shot name. Shot attributes: prepare, prepareplay and loop. Separated with colon. E.g.: “prepare:ShotName” and “prepareplay:ShotName”

• **Time Preview** [Optional]: Duration for move in frames. The time will be rounded up to the nearest second.

For program use:

• **Page Program**: Show and Robotic camera name separated with a colon. E.g.: “ShowName:Cam 1”

• **Preset Program** [Optional]: Shot name. Shot attributes: prepare, prepareplay and loop. Separated with colon. E.g.: “prepare:ShotName” and “prepareplay:ShotName”

• **Fade time Program** [Optional]: Duration for move in frames. The time will be rounded up to the nearest second.

---

4.3.8 Router control

The router control device allows setting crosspoints for source/destination pairs when the template is both cued in preview and aired in program. Add new lines in the router device editor to support setting multiple crosspoint.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source preview</td>
<td>Source to route when template is cued in preview. <strong>Note</strong>: Newsroom tag available</td>
</tr>
<tr>
<td>Dest preview</td>
<td>Destination of routing when template is cued in preview</td>
</tr>
<tr>
<td>Source program</td>
<td>Source to route when template is aired in program</td>
</tr>
<tr>
<td>Dest program</td>
<td>Destination to route when template is aired in program</td>
</tr>
<tr>
<td>matrix</td>
<td>If the router system supports multiple matrixes, select the matrix to use here</td>
</tr>
<tr>
<td>level</td>
<td>0: route on all levels. 1: video routing only. 2: audio routing only. 3: GPI/O routing only</td>
</tr>
</tbody>
</table>
### 4.3.9 eLight control

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PREVIEW COMMAND</td>
<td>Command to use for the light mixer cue to be recalled when template enters preview. <strong>Note</strong>: Newsroom tag available.</td>
</tr>
<tr>
<td>PREVIEW VALUE</td>
<td>Light mixer cue to use when template enters preview. <strong>Note</strong>: Newsroom tag available.</td>
</tr>
<tr>
<td>PROGRAM COMMAND</td>
<td>Command to use for the light mixer cue to be recalled when template is taken on-air. <strong>Note</strong>: Newsroom tag available.</td>
</tr>
<tr>
<td>PROGRAM VALUE</td>
<td>Light mixer cue to use when template is aired in program. <strong>Note</strong>: Newsroom tag available.</td>
</tr>
</tbody>
</table>

**Note**: The commands to use are driver dependent and may vary.

Options for Preview Command and Program Command are available in the drop down list:
<table>
<thead>
<tr>
<th>Command</th>
<th>Parameter count</th>
</tr>
</thead>
<tbody>
<tr>
<td>AllOff</td>
<td>&lt;none&gt;</td>
</tr>
<tr>
<td>Fire</td>
<td>1</td>
</tr>
<tr>
<td>Go</td>
<td>cue number</td>
</tr>
<tr>
<td>GoOff</td>
<td>cue number</td>
</tr>
<tr>
<td>Load</td>
<td>cue number</td>
</tr>
<tr>
<td>NoteOff</td>
<td>numeric note # (Std. MIDI command)</td>
</tr>
<tr>
<td>NoteOn</td>
<td>numeric note # (Std. MIDI command)</td>
</tr>
<tr>
<td>Reset</td>
<td>&lt;none&gt;</td>
</tr>
<tr>
<td>Restore</td>
<td>&lt;none&gt;</td>
</tr>
<tr>
<td>Resume</td>
<td>variable</td>
</tr>
<tr>
<td>Set</td>
<td>4 or 9</td>
</tr>
<tr>
<td>Stop</td>
<td>cue number</td>
</tr>
<tr>
<td>Custom</td>
<td>SysEx bytesSend multiple custom SysEx bytes in the format \xnn where nn is a numeric value (0-255). The global prefix and postfix set in the device config will be used in the message, e.g. abc\x20def will send 7 bytes as a SysEx message.</td>
</tr>
<tr>
<td>TimedGo</td>
<td>- (unsupported)</td>
</tr>
</tbody>
</table>

### 4.3.10 GPI/O

The GPI/O editor is for sending GPOs to external equipment. The editor supports multiple GPO sends. Add a new line in the editor for multiple GPO sends.

- `gpo_preview`: GPO to send when template is cued in preview
- `gpo_program`: GPO to send when template is aired in program
4.3.11 Video wall register recall

This device is only available for Videowall template types.

- **Name**: internal name of the shot.
- **RECALL PREVIE**: For WATCHOUT, see notes below. For the other brands, this is the number of the recall to be taken when the template comes in Preview.
- **EMEMNR**: For WATCHOUT, see notes below. For the other brands, this is the number of the preset to take when the template comes in Program.

**Notes for Watchout**

For WATCHOUT, the fields **RECALL PREVIE** and **EMEMNR** should contain the command or sequence of commands to be sent when the template comes in Preview or Program, respectively.

The general format is: `[load "show"] [reset] [run "timeline"]`

Both **load** and **run** are optional, however at least one of them must be present. The show and timeline parameters may not contain double quotes.

The **reset** value is optional. For more information see the connection string property **ResetAnyway**, described in the section ‘Watchout Connection String’ in the *Viz Mosart Administrator’s Guide*.

In most cases, **RECALL PREVIE** will contain **load "show"**, and **EMEMNR** will contain **run "timeline"**.

4.3.12 Video Server

- **SERVERCHANNEL**: here you choose which server channel is to be used by this template
- **CLIP HIRESPATH**: You can enter the default clip ID, however a clip ID coming from the NCS will override this value. **Note**: Newsroom tag available.
- **CLIP DESCRIPT**: You can enter a Clip description, however a clip description from the NCS or video server will override this value. **Note**: Newsroom tag available.
- **TRIGGER START**: Will enable the Trigger start function from control commands, a shortcut or continue point could be set to PLAY the Clip.
- **RECUE CLIP**: In an A/B roll situation, when several Adlibs are played back-to-back, this setting determines how a clip will be restarted after it has been paused. For example, if Clip A is paused when Clip B is taken to air, then next time Clip A is taken on the same channel, it can either be played from where it was paused, or be recued (played from the beginning). This is only used for AdlibPix templates.
- **LOOP**: Will set the server port to loop the clip, however not all video servers can loop.
- **CUE ONLY**: 
4.3.13 Audio Player

- **LEVEL**: Enter the value for the audio fader to be set to when taken to Program
- **AUDIOFILE**: Enter the default audio file name here, this value will be replaced by a value from the NCS. **Note**: Newsroom tag available.
- **OUTPUT**: Choose the output on the Audio Player to be used, if nothing is inserted, the first port will be used. This value will be overwritten by values coming from the NCS. **Note**: Newsroom tag available.

4.3.14 Virtual Set

Insert the camera number in the virtual set that is to be taken when template is taken to Program.

4.3.15 Audio Settings

Adding audio faders

Add audio faders to the template by right clicking in an empty part of the audio fader area and select **Add fader** from the menu. Set the audio mixer crosspoint from the drop down menu by clicking the label at the top of the fader.

Setting audio levels

- The **main level** for the fader is set by dragging the notch or clicking the arrows. The default fader level when adding a new fader is 0 db.
- To set **level 2** of the fader press **SHIFT** while dragging. A tooltip opens to signal the editing of the level 2 fader level.
- To set **level 3** of the fader press **SHIFT+CTRL** while dragging. A tooltip opens to signal the editing of level 3 fader level. Level 3 is the Mute level of the audio fader.

Setting audio properties

Right click over a fader to open the context menu, with the following options:
### Fader type

**Action:** When a fader control is set as an action fader, the controls simply define whether the fader is enabled or disabled.

**Level:** For normal operation

### Link

Assign a video/audio link group to this fader

### Keep level

Enabled to let the automation open the audio fader, leaving it open until the operator closes it with the Fade audio function in the Viz Mosart client or closes it from another template.

### Fade up in preview

Enable to let the audio fader open when the template is cued in program. Only applies in certain combinations of templates.

### Input device

Set the type of the audio fader. Please note the special handling for the types: 

- **Video server:** automatically assign the correct audio fader crosspoint from your configuration based on the internal A/B rolling
- **External source:** enable external source mode for this fader
- **Mic:** enable microphone mode for this fader
- **Telephone:** enable telephone hybrid mode for this fader

### Crossfade time

Set the in and out crossfade time for the fader

### Manual close

When selected, ignore sending the take out for the fader at end of element. The fader will have to be manually taken down.

### Mode

Only for Studer Vista and Lawo, will send chosen value to the mixerboard for the audio fader.

### Delay

Only for Studer Vista and Lawo, will give a delay value for that audio fader that will be sent to the audio board.

### Loudness

Will send chosen recall value to send to the Junger audio processor.

### Removing a fader

Remove a fader by right clicking over the fader and select Remove fader from the menu.

### 4.3.16 Testing The Template

Test your template by selecting Test template from the menu. This will cue the template in preview then 5 seconds later take it to program with the selected transition.
4.4 Additional Template Functionality

This section contains the following topics:

- State Variance
- Dynamic ME Allocation
- Control Commands in Templates
- Newsroom Tags Order

4.4.1 State Variance

A story sequence is defined to be a sequence of stories containing one story item/template where the template used is the same in all stories. The figure below shows a sequence of three stories where every story contains one single story item using the same Viz Mosart template (VOICEOVER+HEAD).

State variance allows different template variants to be used depending upon the position of the corresponding story in such story sequences.

Typically the first story in a sequence shall behave differently than the remaining stories. Another example is to combine a sequence with music where every story in the sequence has a specific length that is synchronized with the music.

In both examples is it necessary to invoke different templates depending upon the position of the story in the sequence but make it simple for the user to add the stories by just referring to the master template (HEAD in this example).

Note that template variance only works on story level. I.e. only one story item / template should be assigned per story.
Example

The figure above shows how the templates from the headlines example are put into a sequence. The template called HEAD is the **master template**, and the first story with a HEAD variant will use this template. The second story with a HEAD variant will use the template called HEAD2, and HEAD3 will be used for the third story. In this way, the only command (template variant) used in the newsroom system is HEAD, regardless of whether it is the first, second or third.

Therefore the order of the headlines can now be changed without any modification to the script, making it very quick to do last minute changes. In the same way, it can also be defined which template to use if there is only one HEAD, or if the last HEAD template should act in a specific way.

Configuring template state variance

Configuring template state variance is done in the template editor using the Template Properties dialog.

Select any template as the **master template** which will be used as the first template in the sequence. Add additional variants in the sequence using the << and >> arrow buttons. For a particular template type, it is only possible to select variants of the same template type. The same template variant may be used multiple times. Use the **Up** and **Down** buttons to shuffle the variant order.

The following properties are available that gives additional control over which template variant to be used:

- **Reset State** - Index of the variant where to continue if the number of stories in a sequence is larger than the specified number of variants. The index 0 equals the first variant (i.e the master template itself).
• **Reset State After** - Number of stories that do not belong to the sequence before the new sequence is started. This allows the variance sequence to be kept even when there are stories within the sequence that is not part of the sequence itself. See example below.

• **Last State** - Special variant to be used for the last story in the story sequence.

• **Single State** - To be used as the last state when there is only one story in the sequence. Note that when using the single state, the **Last State** needs to be defined.

**Example – Reset State After**

Given a story sequence like in the above picture with three stories all using the HEAD template. In addition, the HEAD template variant has a variance sequence of three item: HEAD, HEAD-2 and HEAD-3. Executing the story sequence will then invoke the template variants "HEAD", "HEAD-2" and "HEAD-3" for the three stories respectively.

Add another story within this sequence like: HEAD, HEAD, OTHER-STORY, HEAD. Executing this story sequence will invoke template variants depending upon the **Reset State After** value:

- **Reset State After <= 1**: HEAD, HEAD-2, OTHER-STORY, HEAD
  I.e. the sequence is restarted since **Reset State After** is less than or equal to 1 (story)

- **Reset State After > 1**: HEAD, HEAD-2, OTHER-STORY, HEAD-3
  The sequence is continued since the **Reset State After** is larger than 1 (story)

**4.4.2 Dynamic ME Allocation**

To be able to use dynamic allocation, the vision mixer must have at least two mix effect banks in addition to your program/preset bank. Viz Mosart will use ME1 and ME2 for the dynamic allocation. The programming of the emem registers on the vision mixer will vary between the different models on the market. Please contact Viz Mosart support for instructions on how to prepare your switcher to work with Viz Mosart's dynamic ME allocation.

When ME’s are included in a template with cross points or an emem recall, it’s possible to do a dynamic selection of the ME, by choosing M_RIP or M_OTH. The reason to use dynamic allocation, could be that you want an effect to load on an ME not in use, or to set a cross point on the ME currently in use.

To allocate a "new" ME in your template, then choose M_RIP (ME ripple). This will load the effect or set cross point on the ME that has the status of "not in use". When this template goes on-air, the status of the ME will change to "in use". The next template that uses M_RIP will then load on the other ME.

The opposite is M_OTH (ME other). Using this in a template will load the effect or set cross point on the ME with the status "in use", and will not cause a change of status between the two ME’s. This means that if the next template also uses M_OTH, it will address the same ME as the previous.

**4.4.3 Control Commands in Templates**

Control commands can be inserted into a template, in order to take a specific command. To add a Control Command, click the **Control Commands tab** in the Template Properties window.

The three categories of control command are **Command On Take**, **Continue Points** and **Command on Take Out**. The table **Command Values and Parameters** lists further information about the available commands.
Command On Take
Commands inserted here will be executed when the template is taken to program or on air.

Continue Points
Commands inserted here will be taken when pressing TAKE NEXT (default F12). Viz Mosart will execute this continue point within the primary template it is inserted in. Each line represents a new continue point.

Cue Next Item Index: Enter the line number of the continue point that shall execute a cue for the next/following Primary object. If empty, Viz Mosart will do a cue when entering the last continue point in the list. Insert 0, 1, 2, 3 etc.

Autotake: Insert the autotake time in frames. The control command continue point will then be automatically taken after that time.
Command on Take Out

Commands inserted here will be executed when the template is taken from program, taken off air, or at the end of the template.

Only a single command can be used in Command On Take Out, and it does accept any parameters.

Command Values and Parameters

⚠️ **Note:** Parameters marked with (*) do not work for templates.

<table>
<thead>
<tr>
<th>Command</th>
<th>Value</th>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>UNKNOWN</td>
<td>N/A</td>
<td></td>
<td>Default fallback. Does nothing.</td>
</tr>
<tr>
<td>AUTOTRANS</td>
<td>PP, ME1, ME2,</td>
<td>MixEffect (MIX OR WIPE) +</td>
<td>Eg. MIX 33, WIPE 10. Effect</td>
</tr>
<tr>
<td></td>
<td>ME3, ME4</td>
<td>Transitionrate</td>
<td>does not work.</td>
</tr>
<tr>
<td></td>
<td>AUX, Default</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TAKE_SERVER_TO_PROGRAM</td>
<td>N/A</td>
<td>transRate (integer) - parameter.</td>
<td>(*)</td>
</tr>
<tr>
<td>SET_CURRENT_ME</td>
<td>PP, ME1, ME2,</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>ME3, ME4, AUX</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Default</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SET_CROSSPOINT</td>
<td>N/A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SET_AUX_CROSSPOINT</td>
<td>N/A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>COMMA ND</td>
<td>Value</td>
<td>Parameter</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>-------</td>
<td>-----------</td>
<td>-------------</td>
</tr>
<tr>
<td>DVE</td>
<td>FORWARD, REVERSE</td>
<td>Recall forward/revers emem</td>
<td>n/a</td>
</tr>
<tr>
<td>FULLSCREEN GRAPHICS</td>
<td>CONTINUE, FULLSCREEN</td>
<td>Engine no</td>
<td></td>
</tr>
<tr>
<td>MACRO</td>
<td>Macro</td>
<td>Macro name</td>
<td></td>
</tr>
<tr>
<td>OVERLAY GRAPHICS</td>
<td>CLEAR, CONTINUE, TAKE_MANUAL_OUTPUT</td>
<td>Engine no</td>
<td></td>
</tr>
<tr>
<td>MACRO</td>
<td>Engine no : macro</td>
<td>eg: 4:macrohere</td>
<td></td>
</tr>
<tr>
<td>PRETAKER_NEXT_OVERLAY</td>
<td>Render (engine no)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TAKE_NEXT_OVERLAY, TAKE_NAMED_OVERLAY</td>
<td>(*)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>OVERLAY_TO_MANUAL</td>
<td>Parameter 1: ONAIR (default), PREVIEW. Parameter 2: Comma-separated list of handler names Parameter 3: AUTOMATIC (default) / MANUAL</td>
<td>For more details, see Control Command Key OVERLAY_TO_MANUAL</td>
<td>Note: If there is no semicolon after Parameter 2; nothing to the right of the semicolon; or Parameter 3 has any value other than 'MANUAL', then Parameter 3 gets the default value 'AUTOMATIC'.</td>
</tr>
<tr>
<td>COMMAND</td>
<td>Value</td>
<td>Parameter</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>-------</td>
<td>-----------</td>
<td>-------------</td>
</tr>
<tr>
<td>WEATHER</td>
<td>N/A</td>
<td>(*)</td>
<td></td>
</tr>
<tr>
<td>AUDIO</td>
<td>FADE_MANUAL</td>
<td></td>
<td>Toggle fade manual</td>
</tr>
<tr>
<td></td>
<td>FADE_OUT_KEEPS, FADE_DOWN_SECONDARY_AUDIO, FADE_UP_SECONDARY_AUDIO</td>
<td>Fader rate</td>
<td></td>
</tr>
<tr>
<td></td>
<td>SET_LEVEL_2_ONAIR, SET_LEVEL_2_PREVIEW, FREEZE_AUDIO</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>DIRECTTAKE</td>
<td>#</td>
<td>-</td>
<td>Uses the value selected in the dropdown</td>
</tr>
<tr>
<td>LIGHT</td>
<td>N/A</td>
<td>(*)</td>
<td></td>
</tr>
<tr>
<td>AUTOTAKE</td>
<td>N/A</td>
<td>(*)</td>
<td></td>
</tr>
<tr>
<td>PLAY_STORY</td>
<td>N/A</td>
<td>(*)</td>
<td></td>
</tr>
<tr>
<td>STUDIOS ETTUP</td>
<td>#</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>VIDEOE ALLMODE</td>
<td>N/A</td>
<td>(*)</td>
<td></td>
</tr>
<tr>
<td>COMMAND</td>
<td>Value</td>
<td>Parameter</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-------</td>
<td>-----------</td>
<td>---------------------</td>
</tr>
<tr>
<td>GRAPHIC SPROFILE</td>
<td>N/A</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>SEQUENCE</td>
<td>LOOP</td>
<td>-</td>
<td>Loop = True</td>
</tr>
<tr>
<td>STOP_LOOP</td>
<td>-</td>
<td>-</td>
<td>Loop = False</td>
</tr>
<tr>
<td>STOP</td>
<td>-</td>
<td>-</td>
<td>TakeOut</td>
</tr>
<tr>
<td>START, TAKE</td>
<td>-</td>
<td>-</td>
<td>Take</td>
</tr>
<tr>
<td>MARKER</td>
<td>N/A</td>
<td>(*)</td>
<td></td>
</tr>
<tr>
<td>VIDEO_SERVER_GOTO</td>
<td>N/A</td>
<td>(*)</td>
<td></td>
</tr>
<tr>
<td>TRANSITION_TYPE</td>
<td>CUT, MIX</td>
<td>Rate</td>
<td></td>
</tr>
<tr>
<td>EFFECT</td>
<td>Effect no</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TOGGLE</td>
<td>(*)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>RECORD</td>
<td>PREPARE, START, STOP</td>
<td>Split parameters using, - first -&gt; clipname, - second -&gt; recorder (optional), - third -&gt; port name (default = Rec), - fourth -&gt; group name (default = Rec)</td>
<td>eg. clip33,recorder1,Rec,Rec</td>
</tr>
<tr>
<td>Command</td>
<td>Value</td>
<td>Parameter</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>--------------</td>
<td>---------------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>DEVICE_PROPERTY</td>
<td>CAMERA CONTROL</td>
<td>Demands <code>&lt;fields&gt;</code> structure as parameter OR connectionstring style</td>
<td>This is for CAMERA ROBOTICS! The 'DEVICE_PROPERTY' control command is only used by Camera Robotics as a way to set speed (Camerobot) and presenter (Camerobot/FxMotion) from a template.</td>
</tr>
<tr>
<td>AUDIO</td>
<td></td>
<td>demands <code>&lt;fields&gt;</code> structure as parameter with parameter1=AUDIO, parameter2=key, parameter3=value OR connectionstring style</td>
<td>This is for AUDIO MIXER!</td>
</tr>
<tr>
<td>CROSSOVERCOMMAND</td>
<td>N/A</td>
<td>(*)</td>
<td></td>
</tr>
<tr>
<td>ACCESSORIES</td>
<td>TAKE_NEXT</td>
<td>(*)</td>
<td></td>
</tr>
<tr>
<td>SET_VIDEO_SERVER_SALVO</td>
<td>N/A</td>
<td>(*)</td>
<td>Not implemented for templates</td>
</tr>
<tr>
<td>SWITCH_VIDEO_SERVER_MIRRORING</td>
<td>N/A</td>
<td>(*)</td>
<td>Not implemented for templates</td>
</tr>
<tr>
<td>SWITCH_GRAPHICSMIRRORING</td>
<td>TOGGLE, ACTIVATE, DEACTIVATE</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Command</td>
<td>Value</td>
<td>Parameter</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-------</td>
<td>-----------</td>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td>ENABLE_GRAPHICS_MIRRORING</td>
<td>N/A</td>
<td>(*)</td>
<td></td>
</tr>
<tr>
<td>HOLD_VIDEO_TRANSITION</td>
<td>N/A</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>HOLD_AUDIO_TRANSITION</td>
<td>N/A</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>NCS</td>
<td>START_STATUS, STOP_STATUS</td>
<td>RUNDOWN STORY ITEM</td>
<td>Specific for Open Media</td>
</tr>
<tr>
<td>TAKE_CONTINUE_POINT</td>
<td>N/A</td>
<td>(*)</td>
<td></td>
</tr>
<tr>
<td>RUNDOWN_NCS_RESYNC</td>
<td>N/A</td>
<td>(*)</td>
<td></td>
</tr>
<tr>
<td>RELEASE_BACKGROUND</td>
<td>N/A</td>
<td>(*)</td>
<td></td>
</tr>
<tr>
<td>VIDEO_PORT</td>
<td>N/A</td>
<td>Must be a comma separated list in the format: command, port, parameter</td>
<td>eg. PLAY_PAUSE,A,PLAY. See Video Port Control Commands</td>
</tr>
</tbody>
</table>

**Parameters with placeholders**

Control commands parameters may contain placeholders which can be replaced with values found in the fields of the Viz Mosart item which is currently on-air. A placeholder is a string of characters in curly brackets, i.e. \{placeholder\}, which can be replaced by field values found in the Viz Mosart item currently on-air. Placeholders can be useful, for example, when it is needed to transmit values from NCS to the control commands to be executed when the template is taken on-air.
Example: Providing the clip name to be recorded from NCS.

In NCS, a column can be created for giving the name of the clip to be recorded with Viz Mosart. Then, in Viz Mosart Newsroomsettings, map the column in Story External Metadata as follow:

```
<mostag mostagname="NCScolumn" mosart_action="item_variable" action_value="NCS_filename"
format_type="String" />
```

In Manus file, one can observe that the Mosart item will have the following fields (the value "Clip1" is given from NCS):

```
<fields>
  <field name="NCS_filename" value="Clip1" />
</fields>
```

Then, in Template Editor, the control command for the respective template will be configured as follows:

```
RECORD PREPARE {NCS_filename}_Test,Recorder,RecPort
```

When the template is executed, a clip with name "Clip1_Test" will be prepared for recording.

4.4.4 Newsroom Tags Order

This gives the possibility to order the newsroom tags so that they are displayed in the selected order in the Viz Mosart’s ActiveX.

In Template Editor open a template and add newsroom tags for some fields in the template (note that not all fields supports adding newsroom tags). For example, enable Switcher Crosspoint on the template, open the Device Properties and click right on the Crosspoint field. Thus you can add a name for this crosspoint (a newsroom tag):
Then open Template Properties and on the *Newsroom tags order* tab you can order the newsroom tags if there are more than one:
The same order will be shown in Viz Mosart ActiveX if this was enabled in the registry through the `SortXpoints` property (see Setting up the Registry for ActiveX).

4.5 Template Examples

This section contains the following examples:

- Studio
- Video Clip with Full Sound
- Voiceover
- Live External Source
- DVE
- Full Screen Graphics

4.5.1 Studio

The template for a typical studio camera is based on the CAMERA type. The example below defines a standard camera 1 variant. An entry named CAM 1 in the video setup is selected at the PP bus cross point. Transition duration is 0 frames (hard cut) and E-mem recall is disabled. There is only one studio microphone, which fader is called "A Mic 1" in this template. Audio level is set to 0 dB,
and the input device is a microphone. The input device type is important for the handling of audio in an ad lib sequence of full camera, DVE and full external source.

![Viz Mosart User Guide - 3.8.1](image)

For our standard camera 2 variant the only difference in the above setup is the PP bus cross point which is called CAM 2.

### 4.5.2 Video Clip with Full Sound

As crosspoint on the vision mixer, we use a source called S_RIP, which means Viz Mosart will use the A/B roll and roll between the sources defined in the AV setup as videoserverA and videoserverB. We choose RIP_C1 as the audio source, but as long as A/B roll is enabled, any source defined as Video server will follow the video source. The default transition is a three frames mix. The video channel control is also enabled and controls the clip. The server channel is automatically assigned within the automation.
4.5.3 Voiceover

In this example the variant VO is defined. Notice the difference from the two last examples and the two fader setups. A Mic 1 is microphone input type and RIP_C1 is video server type.
A second sound level can be set for each fader by using the `SHIFT` key over the fader to set the second level. This second sound level for all faders will be used as the start level for the voice over sound bite type.

The same special variant logic for video clip with full sound applies for the voice-over type.

### 4.5.4 Live External Source

Live external source variants are typically defined by their corresponding vision and audio mixer inputs. In the example below we define variant 1 as source MW 1 on both PP bus cross point and audio fader.
Additional variants 2 to 9 would typically use MW 2 to MW 9 as sources for both video and audio.

4.5.5 DVE

This example recalls a predefined E-mem (emem number 10) defining a split screen DVE on M/E 1 on the vision mixer.

1. E-mem recall definition

The vision mixer effect uses key 1 and key 2 on M/E 1 as left and right split windows. Default crosspoints are chosen, CAM 2 and MW 1, but the crosspoints can be set from the newsroom system, because a newsroom tag has been added for both keys. Right click over the XPOINT window to add a newsroom tag. In addition the template defines a recall of a graphics background
2. Key bus delegation setup
3. Audio linking

![Diagram of audio linking configuration](image)

Pictures 1-4, above, show the key steps to configure this template.

4. Graphics engine data element setup

![Diagram of graphics engine setup](image)

Pictures 1-4, above, show the key steps to configure this template.
Picture 1 shows that the PP bus cross point is set to ME1 (program output of mixer effect). The E-mem recall control is defined to recall emem 10 when the template is taken to preview.

In picture 2 the second key bus delegation is shown. As a default we assign CAM 2 to key bus 1 and MW 1 to key bus 2 on the ME1 mixer effect bus. This assignment can be overridden from the NCS story element by using the newsroom tag. The audio link is set to 1 for both the key 2 delegation and the second fader (MW 1) as shown in picture 3. When using the newsroom tag to set key 2 to a different source, i.e. MW 3, both video and audio delegation will follow, thus key 2 source is set to MW 3 and the second audio fader is set to MW 3.

For setup of the Graphics controller refer to the next section.

4.5.6 Full Screen Graphics

The graphics controller in the Template Editor is vendor specific due to the lack of a modern generic control API. As a general function the component can control multiple graphic engines, i.e. one for your full screen graphics and one for studio wall graphics in addition to your overlay CG engine. For DVE effects this can be a fixed element, whilst for telephone graphics or maps the element name and data are given in the NCS story.

In this example the template is setup with the FULLSCREEN video input (PP cross point) and MIC 1 audio fader. The controller will cue graphics when taken to preview and run them when taken to program.

4.6 AutoTake Timing

4.6.1 Autotake Transition with No Effects

\[ Tat = td1 + tm1 - tm2 \]

- Tat = Time for autotake, relative to t=0
- tm1 = mix delay, story item 1
- td1 = duration, story item 1
- tm2 = mix delay, story item 2
- td2 = duration, story item 2

For clips: td = clip duration - post roll
4.6.2 Autotake Transition with Effects and Mix Delay

\[ Tat = td_1 + tm_1 - tm_2 - te_2 \]

- \( Tat \) = Time for autotake, relative to \( t=0 \)
- \( tm_1 \) = mix delay, story item 1
- \( td_1 \) = duration, story item 1
- \( tm_2 \) = mix delay, story item 2
- \( td_2 \) = duration, story item 2
- \( te_2 \) = effect duration, story item 2

4.6.3 Autotake Transition with Effects and no Mix Delay

\[ Tat = td_1 + tm_1 - te_2 \]

- \( Tat \) = Time for autotake, relative to \( t=0 \)
- \( tm_1 \) = mix delay, story item 1
- \( td_1 \) = duration, story item 1
- \( tm_2 \) = mix delay, story item 2
- \( td_2 \) = duration, story item 2
- \( te_2 \) = effect duration, story item 2
• te2 = effect duration, story item 2
  Mix delay considered part of effect duration
5 Audio Panel

5.1 Audio Panel (Server)

The Audio Panel (AudioPanel) enables the use of a Behringer BCF2000 or JL Cooper MXL with Viz Mosart Server. This application controls data transmission between the physical hardware panel and AV Automation on the Viz Mosart Server.

5.2 Audio Panel (Client)

The Audio Panel (Client) is a software representation of the audio mixer connected to the Viz Mosart Server. It is a replication of current faders, on air faders, and faders in ‘preview’.
The Audio Panel is a separate application and can be accessed in the Viz Mosart folder via: C:\Program Files (x86)\Mosart Medialab\Mosart Audio Panel\AudioPanel.exe

This section contains the following topics:

- Setting up the Connections
- Using the Audio Panel
- Fader Configuration

### 5.2.1 Setting up the Connections

The connection setup to the Viz Mosart Server is done in Tools - Settings - General - Global - Server settings, and should be the same as for a GUI connected to that server.

The Audio Panel requires Manus Administrator and AV Automation to run, and to then have a green connection to that Viz Mosart server in the bottom left corner.

Configuration file is located in C:\ProgramData\Mosart Medialab\ConfigurationFiles or C:\channeltemplates}.

The configuration file will be created on startup of Audio Panel if it does not exist.

### 5.2.2 Using the Audio Panel

#### Setup

An initial setup is required to access the audio mixer via the Audio Panel interface. This is done by going into Tools -> Settings -> General Settings.

Here you will be faced with a small selection of options to properly help you set up your audio fader panel.

**Server Settings:** Server Name, Server Host and Server Host Backup should be changed/configured for use. You can also change the port that the Application uses to communicate with Viz Mosart servers, the default port is 8090.

**Panel Settings:** The Panel settings consists of the following sub-menus; Panel name, Panel type, Panel Port, Panel Index and Set Labels.

#### Server Settings

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server Name</td>
<td>This is the name used by the Audio Panel GUI</td>
</tr>
<tr>
<td>Server host</td>
<td>This can either be the server name OR the IP address + port number</td>
</tr>
<tr>
<td>Server host Backup</td>
<td>Same as &quot;Server host&quot;, for the backup server</td>
</tr>
</tbody>
</table>
Panel Settings

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Panel Name</td>
<td>A self-administered name for the panel</td>
</tr>
<tr>
<td>Panel Type</td>
<td>The type of connection used for the audio panel, e.g. MIDI, RS422, RS232</td>
</tr>
<tr>
<td>Panel Port</td>
<td>The specific port used in the above connection (e.g. COM3)</td>
</tr>
<tr>
<td>Panel Index</td>
<td>You can utilize several panels which could have an individual number</td>
</tr>
<tr>
<td>Set Labels</td>
<td>Check if you wish to send label information back to the panel, only for panels with LCD label buttons.</td>
</tr>
</tbody>
</table>

**User interface:** Use these settings to Bank faders on the JL Cooper Panel.

- **Midi Bank Commands:** specifies MIDI controls on the JL Cooper Panel. Default values corresponds to F1, F2, F3 and F4 keys.
- **Show Banks:** if enabled, it will show the bank associated with each fader in Audio Panel GUI on the top side for each fader.
  The bank for each fader can be changed by right clicking on the fader label and selecting the bank from the displayed pop-up list.

In the Show menu there are options to show MIDI commands and to highlight in orange the selected bank on the faders.

By right-clicking on any fader, and selecting Edit, you can configure properties of the fader’s operation.

**5.2.3 Fader Configuration**

**Fader Edit Menu**

| MI DI Learn | Assigns any physical fader on the Audio Remote Panel to the selected fader in the Audio Panel GUI. After selecting this function, move the fader on the physical mixer so Audio Panel will learn and memorize this function |
MI
DI
Cle
ar
Deletes the assigned physical fader from the Audio Panel.

Fa
der
Mo
de
Selects whether the logical fader should work in Preview, Program or as a Generic fader which is constantly in use. - Program: Retrieves the active faders from the template in the program. The virtual fader will become visible, and can be adjusted when On-Air. - Preview: Retrieves the active faders from the template in preview. It permits you to change the levels while it is in preview, before it is taken on air. - Generic: Simple remote operation of a physical fader on an audio mixer. Constantly connected from the same source. Locks the fader to the same source, e.g. (Mic 4) will always remain static in the Audio Panel GUI and not change based on current story in the Viz Mosart GUI. See Also Selecting a Source.

Fa
der
Ty
pe
Check if you wish to send label information back to the panel, only for panels with LCD label buttons.

Mo
ve
Moves the selected fader UP or DOWN in the Audio Panel GUI

Selecting a Source
If you are using the Generic fader mode, a source from the source list can be selected by right-clicking in the area where labels are listed.
Check default number of faders.
Input selection can be configured by right-clicking the "fader header" and select fader names.
You can select a fader label by right clicking on the label (just below the fader header) and selecting the appropriate function in coordination with your audio mixer.

Note: Selecting "ANY" could remove the label. If no label is present, then the ANY function would be the selected label... if one wishes to change the label again, select another label the fader-edit menu (right click on the actual fader), and select a new label in the "fader-type" sub-menu

Assign Function Keys
In any of the function buttons below the GUI faders, you can assign to any of the function keys on a physical audio panel. This setup also utilizes MIDI Learn and MIDI Clear. In addition you can select the preferred function, e.g. Mute, Standby, PFL.
Update After Viz Mosart Server Switching

The server that the Audio Panel GUI is connected to follows the Viz Mosart GUI, switching between a main and backup server in the Viz Mosart GUI will automatically configure the selected server in the Audio Panel GUI accordingly.
6 Audio Player

The Audio Player is part of the Viz Mosart installation and may be used to play out audio files located on the file system. This is useful to play out audio files that are used on a regular basis, such as for openers and audio-beds.

The Audio Player supports the formats: mp3, wav, wma, aac, m4a, mp4, aiff, avi

⚠️ **Note:** A broadcast sound card is required for audio output. If you are running the Audio Player on a Windows Server, also install Windows Audio features on this machine, otherwise the various audio formats will not work.

⚠️ **Note:** The Audio Player replaces the discontinued Soundfile Player.

This section contains the following topics:

- How to Set Up Audio Player
- Overview of Audio Player GUI
- Overview of Audio Player Settings

6.1 How To Set Up Audio Player

1. Install Audio Player, then start it.
2. Open AV Automation
3. Go to Devices > Preferences > Audio > Sound player
4. Check "Use sound player" and choose Viz Mosart Audio Player
5. Under "Host" write the IP address to the computer where Audio Player is running.
6. Under "Default directory" write the folder path where the audio files that will be used is stored.
7. Restart AV Automation and check that the connection is green.
6.2 Overview Of Audio Player GUI

- **Settings button**: Opens a settings window that is used to configure the Audio Player.
- **Audio Directory**: The Audio Directory displays the folder path to the folder where the audio files are. This path is chosen in the AV Automation preferences. All files in this folder is ready to be played.

```
Audio Directory: C:\Lydvignet\Nyhetsskanalen
```

- **Output list**: Shows a list of all available devices. The first number is the number you use in AV Automation/NCS to choose which output the audio file should be played on.

```
1: Output 1 Stopped (Primary Sound Driver)
2: Output 2 Stopped (Line Out (4- Scarlett 2i4 USB))
```

- **Log panel**: Shows all log messages that the audio player logs.

```
9 LiveSoundService AVAutomation pinged the service
11 LiveSoundService AVAutomation stopped pinging
```

- **AVAutomation status**: Shows green if AV Automation is connected and red if its not.

```
[Green] AVAutomation  [Red] AVAutomation
```

- **IP Address**: Displays the Ip address of the computer Audio Player is running on.

```
10.211.114.132
```

- **Version**: Displays the version number of the Audio Player.
6.3 Overview Of Audio Player Settings

- **Testing Panel**: Turn On to show the panel for testing the Audio Player. Testing panel can be used to test the functionality of the audio player.
- **Buffer Size**: The size of the playback buffer (Higher = smoother playback, Lower = lower response time)
- **File already playing**: This option controls what Audio Player does if a new file is played when there is already a file playing.
  - Stop the file playing, and play new file

- **Output editor**: The list on the left shows all the outputs, and the list on the right shows all available Playback devices on the computer. The line between them shows which playback device the output will use to play the audio file. You can click on the outputs to map them to another playback device, renaming the output or delete the output. Click the new button to
add another output.

- **Tooltip box**: Shows tooltip for the setting you are hovering with your mouse.

**Testing Panel**

*Turn On* to show the panel for testing the Audio Player. Testing panel can be used to test the functionality of the audio player.
7 Timing Display

The Timing Display (WPFTimingInfo) is used to provide timing information to the studio control room and the studio floor.

The timing display is synchronized to the current rundown in the Viz Mosart GUI, and you can run as many customized Timing Display applications as you need for the production.

The Timing Display also has a customizable audio countdown feature that can be connected to an in house intercom system or a direct monitor speaker in the control room or studio floor. It can be enabled to count on certain events.

Viz Mosart provides an English voice set for use with the Timing Display, however the broadcaster may decide to localize the voice set by recording their own.

For example, the Timing Display can be running on the studio floor and be connected to the in house intercom system to provide an audible count to the presenter’s earpiece. Another Timing Display can be running in the control room with a monitor speaker for countdown out of packages for the producer to keep current with the production.